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3ds Max FBX plug-in
What’s New

The following section contains the new features for this version of the 3ds Max FBX
plug-in.

NOTE

Consult the readme file for any last-minute changes to this release. Find the readme,
along with this Help system, in the Program Files > Autodesk FBX folder.

What’s new in this version
This section lists the new features included with this version of the 3ds Max
FBX plug-in. Click the hyperlinks below to see more details.

FBX Help Documentation changes

As of this release, all FBX Help documentation is available from a website, rather
than installed locally.

Click the Help on FBX button in the plug-in to access documentation online.

The Autodesk FBX Help option has been removed from the Autodesk Maya and
3ds Max Help menus. You can now find FBX information included as a part of
the Maya and 3ds Max help documentation.

NOTE If you want to install the Help locally, the FBX help is available for download
online at www.autodesk.com/fbx-help.
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Improved import/export performance

Import of FBX files is now up to 30% faster in certain applications using FBX
2012, thanks to focused development effort on file reading performance,
including the import of triangulated meshes.

Morpher targets

The FBX 2012 plug-in now supports progressive morphs. You can now
export/import multiple morph targets and progressive morphs can be
transferred to Maya as in-between blend shapes.

Vector Displacement Maps support

New support for Vector Displacement Maps (VDMs) in FBX 2012, lets you
transfer complex high-resolution details created in Mudbox 2012 to other
applications for rendering on low-resolution geometry.

VDMs can represent directional displacements that do not simply follow the
normal: for example, forms with appendages, undercuts, folds, and bulges,
such as a human ear; support for rendering VDMs is now included with Maya
2012, 3ds Max 2012, and Softimage 2012.

Visibility inheritance behavior enhancements

The visibility of hierarchical objects has been improved, especially in the area
of joint hierarchies.

Lines/Splines support

The 3ds Max FBX plug-in now supports 3ds Max splines and you no longer
need to convert splines to meshes.
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New Triangulate export option

A new Triangulate option has been created to let you create more robust and
accurate tessellation. See Triangulate (page 39) for more information.

Auto-key type support

New support has been added for Auto-tangent animation curve key types, so
that the keys automatically adjust tangents when you move keys. This lets
you accurately exchange F-curve data between products in the Autodesk
Entertainment Creation Suites 2012. This key type has been added to Maya
2012, providing consistency with 3ds Max 2012, MotionBuilder 2012, and
Softimage 2012.

Mudbox layered texture blend mode support

More blend modes for layered textures were added and converted to the
corresponding blend mode of 3ds Max, providing better compatibility with
Mudbox.

Importer File/System FPS statistics

The Importer Statistics now display the frame rate used (frames per second)
in the imported scene and the application. These statistics let you know if
there is a mismatch between the FBX file frame rate and its host application.
For more, see Statistics (page 64).

Global Ambient light setting

A new setting, Global Ambient Light (page 77) lets you import the ambient
color of a FBX file into the scene. This option is useful if you want to use the
ambient color setting of an FBX file to update your scene.
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Materials custom attributes support

Support for material custom attributes has been enhanced, allowing for better
export/import. This support includes hardware materials such as CGFX and
HLSL.

Substance materials export support

New and updated texture classes in FBX 2012 provide support for Substance
procedural textures. These dynamic, resolution-independent textures have a
tiny disk space footprint, and can be exported to certain games engines via
the Substance Air middleware offering (available separately from Allegorithmic),
or converted to bitmaps for rendering.

A library of 80 Substance textures is included with both Maya 2012 and 3ds
Max 2012.

Nested layered textures support

Improvements to textures support in the FBX 2012 version mean you can
now work with multi-level layered textures. Only single layered textures were
supported in previous versions of FBX.

The following image illustrates a Layered Texture hierarchy:
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COLLADA (.dae) support improvements

New support for lines and arcs, together with improved robustness, enable a
wider range of COLLADA data sets to be imported into a pipeline using FBX
2012.

Conversion support
The following sections are about how the 3ds Max FBX plug-in converts 3ds
Max objects and their properties.

For a detailed report of conversion support for this version, see the 3ds Max
Compatibility Chart. The FBX compatibility chart explains what is supported
and at what level, when you export from Autodesk 3ds Max and import into
Autodesk Maya, Autodesk Mudbox or Autodesk MotionBuilder.

Camera support

The following tables indicate how both 3ds Max and the FBX file format treat
cameras.

Camera export

The following table lists 3ds Max cameras and how the FBX file format treats
them on export:

Becomes in FBXIn 3ds Max

Camera without interest.Free Camera

Camera with interest.Target Camera

Roll FCurve. The plug-in inverts Angle values
when exporting to FBX to maintain a con-
sistent orientation.

Roll Angle Animation
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Becomes in FBXIn 3ds Max

The Orthographic setting which you apply
in 3ds Max to a free or target camera is re-
tained in FBX.

Orthographic Camera

Field of view FCurve. The view is consistent,
even though the focal length values
changes.

FOV channels

Horizontal Aperture.Width-related FOV

Vertical Aperture.Height-related FOV

Near and Far values if clipping is active.
Since you cannot animate Near and Far

Near and Far plane

values in MotionBuilder, it uses the current
time value to evaluate the resulting Near
and Far value.

NOTE

The Up Vector animation is plotted on the Roll FCurve. If not animated, the
plug-in always exports it as (0,1,0). Camera Scale is not supported. Environment
Planes are also not supported.

Render setup

When the 3ds Max FBX plug-in exports cameras, the exporter sets the Render
Output Size and Pixel Aspect Ratio for all cameras based on the current Render
Setup dialog settings. If no user-created cameras exist, the render Output Size
and Pixel Aspect Ratio values are not exported.

Camera import

The following lists how 3ds Max treats MotionBuilder cameras on import:

Becomes in 3ds MaxIn FBX

Free camera.Free Camera
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Becomes in 3ds MaxIn FBX

Target camera.Camera (With a look-at Target/Interest)

Camera with an Orthographic setting.Orthographic Camera

Custom camera import

When the 3ds Max FBX plug-in imports Maya and 3ds Max cameras, the
Render Output Size and Pixel Aspect Ratio applied to the scene is set by the
current camera in the FBX file. That is, the Render Output Size and Pixel Aspect
Ratio from additional cameras are ignored. If the current camera is not a
user-created camera, the Render Output Size and Pixel Aspect Ratio values are
not imported.

Light support

The following tables list 3ds Max lights and how the plug-in treats them on
export to FBX and reimport to 3ds Max:

Standard lights

When imported back into 3ds Max:In 3ds Max

OmniOmni

Free DirectionalFree Directional

Free DirectionalTarget Directional

Free SpotFree Spot

Target SpotTarget Spot

OmniSkylight

Target Spotmr Area Spot
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When imported back into 3ds Max:In 3ds Max

Omnimr Area Omni

NOTE

In non-Revit to 3ds Max workflows, the 3ds Max FBX plug-in does not support
Skylights (and their targets). Instead the plug-in converts them to null objects.
The plug-in also converts mr Lights to Standard lights (for example, an mr
Area Omni Light becomes a standard omni light) and Photometric lights
become Standard lights (where they lose any Photometric-specific values).

Photometric lights

When imported back into 3ds Max:In 3ds Max

Omni. The target is exported as a null.Target light

Omni lightFree light

Omni lightmr Sky portal

Custom properties/attributes

This section show custom properties and attributes and the status of their
support in the 3ds Max FBX plug-in.

Custom attributes

The following table lists 3ds Max custom attributes and whether they are
supported when exported to the FBX file format.

SupportAttribute

SupportedAngle spinner

SupportedAngle Slider
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SupportAttribute

SupportedArray drop-down list

SupportedArray Combo box

SupportedArray list box

SupportedBoolean Check box

SupportedBoolean Check button

SupportedRGB Color picker

SupportedFloat spinner

SupportedFloat slider

SupportedfRGBA Color picker

SupportedInteger spinner

SupportedInteger slider

Not supportedMaterial button

Not supportedNode pick button

SupportedPercent spinner

SupportedPercent slider

SupportedString

Not supportedTexture Map button
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SupportAttribute

SupportedWorld units spinner

SupportedWorld units slider

User-defined properties

The FBX file format supports 3ds Max user-defined properties. They are stored
in the FBX file as custom properties and labeled as UDP3DSMAX.
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Installing the 3ds Max
FBX plug-in

The 3ds Max FBX plug-in is used by 3ds Max® to import, export, and convert files
using the FBX file format. This chapter describes how to install the 3ds Max FBX
plug-in for Windows® XP (32/64-bit), Windows® Vista (32/64-bit), as well as
Windows® 7 (32/64-bit).

The 3ds Max FBX plug-in comes with 3ds Max and is installed automatically. This
procedure is included so you can upgrade your 3ds Max FBX plug-in with later
versions.

NOTE

The 3ds Max FBX plug-in that accompanies your version of 3ds Max may not be the
most recent version. It is a good practice to check for updates, as each subsequent
3ds Max FBX plug-in version has enhanced functionality, and is available free. See
Web updates (page 20) for instructions on how to verify that your plug-in version
is the latest.

NOTE

The 3ds Max FBX plug-in runs only on the version of 3ds Max for which it is created.
Verify that the 3ds Max FBX plug-in you are installing is appropriate for your version
of 3ds Max, and that you are using the latest plug-in version. Otherwise 3ds Max
rejects it. See Downloading the 3ds Max FBX plug-in (page 16).

Windows installation
The 3ds Max FBX plug-in is available for Windows.

3
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Windows compatibility

The 3ds Max FBX plug-in is compatible with the following versions of Microsoft
Windows®:
■ Windows XP (32/64-bit)

■ Windows Vista (32/64-bit)

■ Windows 7 (32/64-bit)

To install the 3ds Max FBX plug-in:

1 Exit 3ds Max.

NOTE

If you install the 3ds Max FBX Plug-in while 3ds Max is operating, the
installation cannot occur. You will receive an “Error opening file for
writing” message.

NOTE

If you have previously installed older versions of the FBX Plug-ins, you
may need to remove these plug-in files manually. These files are removed
automatically during the installation process, but if you receive an error
or warning when you run the plug-in, check for older versions of the
plug-in files and remove them manually. To do so, search and delete the
following files: fbxmaxexp.dle and fbxmaximp.dli.

The current 3ds Max FBX plug-in is named fbxmax.dlu and must be the
only installed version of the 3ds Max FBX plug-in.

2 Download the install file from the Autodesk web site
http://www.Autodesk.com/fbx. See Downloading the 3ds Max FBX plug-in
(page 16) for information on downloading the latest 3ds Max FBX
plug-in.

3 Double-click the install file to launch the Autodesk 3ds Max FBX Plug-in
installer.

4 Click I accept to accept the terms of the license agreement, and then
click Next.
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5 The next window shows the recommended installation location for the
plug-in. To specify another location, click Browse to launch the file
browser.

NOTE

If you install the 3ds Max FBX plug-in to a different location, the plug-in
will not run automatically at startup. This is because 3ds Max
automatically searches the default directory for the plug-ins. If you specify
another directory you must run the plug-in manually from that location.

6 Click Next.

7 The next window shows the recommended installation location for the
plug-in documentation. To specify another location, click Browse to
launch the file browser.
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8 Click Install.

9 A series of dialog boxes appear asking if you would like to keep older
versions of the plug-in (if applicable), open the plug-in documentation
or view the read me file. Select Yes or No for each of these options.

NOTE

If you do not want to lose access to the FBX plug-in that ships with 3ds
Max, select Yes to accept saving copies of the old plug-in whenever you
install newer versions of the FBX plug-ins

10 The Installation completed window appears. Click Close to exit the
installer.

The 3ds Max FBX plug-in is now installed.

Downloading the 3ds Max FBX plug-in
The 3ds Max FBX plug-in is available for free download.

NOTE

The 3ds Max FBX plug-in that accompanies your version of 3ds Max may not
be the most recent version. It is a good practice to check for updates, as each
subsequent 3ds Max FBX plug-in version has enhanced functionality, and is
available free. See Web updates (page 20) for instructions on how to verify
that your plug-in version is the latest.

To download the 3ds Max FBX plug-in:

1 Go to www.autodesk.com/fbx.
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2 Click the Download FBX Plug-ins and Tools link for the latest SDK and
FBX plug-ins releases.

3 Click the FBX Plug-ins, Converter, and QuickTime Viewer downloads
link.

You are taken to a page where the plug-ins reside.

NOTE

The FBX plug-ins are categorized by type, operating system, then
application version.

4 Click the FBX Plug-in link to download the corresponding FBX installer.

NOTE

To find older versions of the FBX Plug-ins, click the Plug-in and Converter
Archives link at the bottom of the web page.

Checking your FBX version number
Once you complete the installation, run the 3ds Max FBX plug-in. The header
of the FBX Exporter and Importer windows in 3ds Max displays the FBX
Version number.

The 3ds Max FBX plug-in that accompanies your version of 3ds Max may not
be the most recent version. It is a good practice to check for updates, as each
subsequent 3ds Max FBX plug-in version has enhanced functionality, and is
available free. See Web updates (page 20) for instructions on how to verify
that your plug-in version is the latest.

Removing the plug-in
When you install the 3ds Max FBX plug-in two instances of the plug-in are
installed on your computer: the actual FBX plug-in that is saved in the source
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directory (C:\Program Files\Autodesk\3ds Max 2012\stdplugs) and a copy
that is stored in the FBX folder that you specified during the installation.

The installation screen specifies a destination folder

When you uninstall the 3ds Max FBX plug-in, the process removes only the
plug-in copy from the destination folder you specified during the installation.
To remove the FBX plug-in completely, you must delete it manually. The
reason you must perform a manual deletion is because the FBX plug-in is a
part of the default 3ds Max installation.

Essentially, when you uninstall, you remove the contents of the FBX backup
folder, for example, C:\Program Files\Autodesk\FBX\FBXPlugins\2012.0\3ds
Max 2012 64-bit, as well as any related entries in the Start menu.

It is good practice to keep the previous version of the plug-in, especially if you
are working on a project where your workflow is heavily dependent upon the
plug-in. If the newer version of the plug-in disrupts your process in some way,
you can revert to the previous version. If you do not want to lose access to
the FBX plug-in that ships with the 3ds Max software, select Yes when asked
if you want to accept saving copies of the old plug-in. This option occurs
whenever you install newer versions of the FBX plug-ins.
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FBX Plug-in UI

This section describes the 3ds Max FBX plug-in user interface. Options and menus
are contained within rollout menus that you can expand and collapse.

Basic UI options
The buttons in this section are common to the 3ds Max FBX plug-in user
interface (UI) and are available whenever the UI is displayed.

Help

Click the Help on FBX button in the information rollout to access the 3ds Max
FBX plug-in documentation.

4
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NOTE The FBX Help documentation is available from a website, rather than
installed locally. To install the Help locally, the FBX help is available for download
online at www.autodesk.com/fbx-help.

Web updates

Click the Web Updates button to make sure that you are using the latest
version of the 3ds Max FBX plug-in.

This function searches the Autodesk web site to check if there is a newer
version of the plug-in that you are currently using.

If you have the latest version, the following message appears:

If a newer version of the 3ds Max FBX plug-in exists, a window appears to
inform you.

See Downloading the 3ds Max FBX plug-in (page 16) for information on
downloading and installing the latest 3ds Max FBX plug-in.

About

Click the About button to view information about the 3ds Max FBX plug-in.

Edit

You can use the Edit preset button to create and save custom presets with
option settings that you define.
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Access the Edit/Save preset options through the Edit button in the FBX plug-in
UI.

The 3ds Max FBX plug-in stores custom presets in a file so you can share them
with other users. See Storing presets (page 21) for more information.

See Editing a preset (page 23) for information about how to create custom
presets.

Ok

The OK button starts the export or import process.

Cancel

The Cancel button closes the FBX Export or Import window without
performing any action.

Storing presets
You can save your custom presets in a file that you can share with other users.
Consult the table for the location of your saved presets.

Preset locationFBX Version

C:\My Documents\3dsmax\FbxPresets2009.4 (and earlier)

Storing presets | 21



Preset locationFBX Version

C:\My Documents\3dsmax\FBX\Presets2010.0 (and later)

Preset files have the file extension .fbximportpreset (for import) and
.fbxexportpreset (for export), for example, My Preset.fbximportpreset.

Creating a custom preset
You can create your own preset with options specific to the kind of import or
export you want to perform. You can also modify existing presets with custom
option settings and UI layouts using the Edit preset mode. See Editing a preset
(page 23).

To create a custom preset

1 Configure the FBX importer or exporter with the settings and UI layout
you want.

2 Click Edit > Save preset.

3 Type the name of the new preset for example, “My preset”.

4 Click OK. For information about changing your custom preset, See Editing
a preset (page 23).

NOTE

You cannot save Bake Animation Start/End/Step values in presets. The 3ds
Max FBX plug-in always derives these values from the scene being exported.
For more information, see Preset Bake Animation settings (page 121).
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Editing a preset
You can modify existing presets with custom option settings and UI layouts
using the Edit preset mode.

1 Click Edit > Edit preset.

2 A dialog box opens to inform you that you must right-click a tree view
item to edit its parameters. Click Ok.

3 This action splits the UI into two sections, and adds a tree view of the
FBX options in the left section.

4 Right-click elements in the Tree View to access the Edit options.
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NOTE

Some edit options are common to all structure levels, while some are
specific to a particular structure level. You can apply some options at
any level of the options structure. See Edit mode options (page 24).

Edit mode options

Use the Edit Mode options to customize your FBX UI preset.

Show/Hide

This option activates or disables the visibility of a group or option in the UI.

Enable/Disable

This option locks the group or option so that it appears grayed-out in the UI
and cannot be modified.

View as expandable group/View as expanded Panel

This option lets you set whether a group is expandable or not.
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Downloading the 3ds Max FBX plug-in
The 3ds Max FBX plug-in is available for free download.

NOTE

The 3ds Max FBX plug-in that accompanies your version of 3ds Max may not
be the most recent version. It is a good practice to check for updates, as each
subsequent 3ds Max FBX plug-in version has enhanced functionality, and is
available free. See Web updates (page 20) for instructions on how to verify
that your plug-in version is the latest.

To download the 3ds Max FBX plug-in:

1 Go to www.autodesk.com/fbx.

2 Click the Download FBX Plug-ins and Tools link for the latest SDK and
FBX plug-ins releases.

3 Click the FBX Plug-ins, Converter, and QuickTime Viewer downloads
link.

You are taken to a page where the plug-ins reside.
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NOTE

The FBX plug-ins are categorized by type, operating system, then
application version.

4 Click the FBX Plug-in link to download the corresponding FBX installer.

NOTE

To find older versions of the FBX Plug-ins, click the Plug-in and Converter
Archives link at the bottom of the web page.

Removing the plug-in

When you install the 3ds Max FBX plug-in two instances of the plug-in are
installed on your computer: the actual FBX plug-in that is saved in the source
directory (C:\Program Files\Autodesk\3ds Max 2012\stdplugs) and a copy
that is stored in the FBX folder that you specified during the installation.

The installation screen specifies a destination folder

When you uninstall the 3ds Max FBX plug-in, the process removes only the
plug-in copy from the destination folder you specified during the installation.
To remove the FBX plug-in completely, you must delete it manually. The
reason you must perform a manual deletion is because the FBX plug-in is a
part of the default 3ds Max installation.

Essentially, when you uninstall, you remove the contents of the FBX backup
folder, for example, C:\Program Files\Autodesk\FBX\FBXPlugins\2012.0\3ds
Max 2012 64-bit, as well as any related entries in the Start menu.

It is good practice to keep the previous version of the plug-in, especially if you
are working on a project where your workflow is heavily dependent upon the
plug-in. If the newer version of the plug-in disrupts your process in some way,
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you can revert to the previous version. If you do not want to lose access to
the FBX plug-in that ships with the 3ds Max software, select Yes when asked
if you want to accept saving copies of the old plug-in. This option occurs
whenever you install newer versions of the FBX plug-ins.

Checking your FBX version number
Once you complete the installation, run the 3ds Max FBX plug-in. The header
of the FBX Exporter and Importer windows in 3ds Max displays the FBX
Version number.

The 3ds Max FBX plug-in that accompanies your version of 3ds Max may not
be the most recent version. It is a good practice to check for updates, as each
subsequent 3ds Max FBX plug-in version has enhanced functionality, and is
available free. See Web updates (page 20) for instructions on how to verify
that your plug-in version is the latest.
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Export

This chapter contains information about options you can use in the 3ds Max FBX
plug-in exporter window.

Exporting from 3ds Max to an FBX file
To export your 3ds Max scene:

1 In 3ds Max, select Application Menu > Export from the main menu bar.
A file browser appears.

2 Select Autodesk (.FBX) in the Save as Type field, name the file and browse
to the location where you want to save the FBX file.

3 Click Save. The FBX Exporter window opens.

5
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4 If you want, select a preset from the Current Preset menu. The Autodesk
Media and Entertainment preset contains the best balance of options
for a general animation workflow. See Autodesk Media & Entertainment
preset (page 31) for more information.

You can also select your own options for export from the FBX Exporter
window. For more information about export options and which are
appropriate for you, review the Export (page 29) section.

5 Click Ok.

NOTE To cancel the export process, press ESC.

If conversions or errors occur during the export process, the Warning Manager
reports them at the end of the process. See Show/Hide Warning Manager (page
54) for information about the Warning Manager.

NOTE There is a difference between “Errors” vs. “Warnings”. The plug-in reports
an error when something unexpected occurs. When the plug-in reports an error,
it indicates that the consequences of that error are unknown. Warnings inform
users when the plug-in applies conversions to the source data to convert the data
into a format that the destination application can read.

Export presets
The 3ds Max FBX plug-in has one export workflow preset:

■ Autodesk Media & Entertainment preset (page 31)
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Autodesk Media and Entertainment is the default preset for the 3ds Max
Exporter.

Selecting a preset

Choose your preset by selecting it in the menu of the FBX Plug-in “Presets”
section.

Editing presets

If you change a preset, the preset field displays User defined, to show that the
preset differs from its default state. The plug-in saves the User defined state
in a temporary file so that the settings are the default the next time you use
the plug-in.

You can also use Edit > Save preset to save your settings as a custom preset.
See Creating a custom preset (page 22) and Editing a preset (page 23).

Autodesk Media & Entertainment preset

The Autodesk Media and Entertainment preset contains the optimal settings
for most animation workflows.
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Autodesk Mudbox preset

The Autodesk Mudbox preset lets you use export options that are the optimal
default settings for work between 3ds Max and Mudbox.

This preset is the same as the default Autodesk Media & Entertainment preset
except that the Preserve edge orientation option is disabled. See Preserve edge
orientation (page 39) for an explanation of this setting.

Edit/Save preset

You can use the Edit preset button to create and save custom presets with
options that you define.
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Access the Edit/Save preset options with the Edit button in the FBX Exporter
UI.

The 3ds Max FBX plug-in stores custom presets in a file so you can share them
with other users. For more information, see Storing presets (page 21).

For more about creating and editing presets, see Creating a custom preset
(page 22) and Editing a preset (page 23).

Include
The Include rollout lets you decide what data and conversions the plug-in
applies to your scene at export from a host application.
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Geometry

Expand the Geometry rollout to access options related to exporting geometry
from your scene.

Smoothing Groups

Activate this option when you want to include Smoothing Groups information
in your exported FBX scenes.

This option is disabled by default in the Autodesk Media & Entertainment
preset.

NOTE

When you disable this option, only explicit normals are exported with the
file.

Smoothing Groups and Collada

The FBX Collada exporter does not export Smoothing Groups data from 3ds
Max. Because of this, the FBX Collada importer generates Smoothing Groups
during the import process when the Smoothing Groups option is activated.
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If you disable the Smoothing Groups option, which is the default state, the
FBX Collada importer does not generate Smoothing Groups for a faster import.

Split per-vertex Normals

Activate this option in order to split geometry vertex Normals based on edge
continuity.

NOTE

This option only applies to older MotionBuilder workflows so you can ensure
visual fidelity of surface continuity. It lets you transfer hard edge information
to MotionBuilder. This transfer is required because of a MotionBuilder
limitation found in versions 2010 and earlier.

Do not use this option if you do not require hard edges in MotionBuilder,
since this operation duplicates vertex information and converts geometry.

When do I use this?

Use this option to preserve whether edges are hard (divided) or not
(continuous) when you operate between 3ds Max or Maya and MotionBuilder
2010 and earlier. If you disable this option, all Smoothing Groups in 3ds Max
are ignored as well as all hard/soft edge information in Maya.

For example, a 3ds Max-created box that would normally have defined edges
would lose them, with all faces visually connected, without visible edges
dividing them, in MotionBuilder. This is result is hardly noticeable for organic
objects, but is very noticeable on hard surfaces such as tables and cars, and so
on.

See the Split per-vertex Normals workflow to import FBX files exported from
3ds Max into MotionBuilder with proper edge continuity while retaining the
original 3ds Max edge continuity for import back into 3ds Max.

Split per-vertex Normals workflow:

1 Export from 3ds Max with the Split per-vertex Normals option activated.

2 Import your scene in MotionBuilder using FBX File Import, finalize your
animation and click Save to resave the FBX file.

3 In 3ds Max, import the FBX file with your original 3ds Max scene open.
Choose Include > File content > Update scene elements to import/update
only the animation in the scene.
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(Above) Split per-vertex Normals option disabled on export produces this
result in MotionBuilder 2010 and earlier.

(Above) Split per-vertex Normals option activated on export produces this
result in MotionBuilder 2010 and earlier.

Tangents and Binormals

Activate this option if you want the 3ds Max FBX plug-in to create Tangents
and Binormals data from UV and Normal information of meshes. This way
you have a Tangent space representation of your meshes that you can use for
advanced rendering.

NOTE

Your geometry must have UV information, or the 3ds Max FBX plug-in cannot
create Tangents and Binormals.

Why do I want to do this?

Exporting tangent and binormal data is useful when you need to define the
local coordinate system for each vertex in the mesh, which is referred to as
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“Tangent space”. This is often required for advanced rendering techniques
such as Normal mapping.

The 3ds Max FBX plug-in reads the UV data and uses it to calculate the Tangent
space data for normal perturbation in per-pixel lighting.

TurboSmooth

Use TurboSmooth to export the source mesh (non-tessellated version) and
the TurboSmooth attributes, for objects with an active TurboSmooth modifier
applied.

If you disable this option, the tessellated version of the mesh is exported. To
export the source mesh, turn off the TurboSmooth modifier in 3ds Max, and
export.

Preserve Instances

Activate the Preserve Instances option to preserve instances in the FBX export.
If you disable this option, exported instances are made unique (converted to
copies).

NOTE  When you activate Preserve Instances, 3ds Max reference objects export
to FBX as a copy (not an instance). The Reference objects then lose their instancing
properties.

Selection sets

Objects and all Editable Poly/Mesh & Poly/Mesh Select modifier sub-object
(component) selection sets are supported for export and import with the 3ds
Max FBX plug-in.

Activate this option to export Selection sets. Disable this option if you do not
want Selection Sets exported with your file. This option is disabled by default.
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NOTE

To avoid name clashing, the 3ds Max FBX plug-in must rename Sub-object
Named Selection sets on export. This is because the 3ds Max FBX plug-in does
not distinguish between edges and borders, or polygons and elements. Because
borders contain edges, and elements contain polygons, FBX must identify
these Sub-objects and add a suffix. For example, if you had a Sub-object Named
selection set of one vertex called “OneVertex” that belonged to Box01, on
export it becomes renamed “Box01_OneVertex”.

When should I not do this?

Activating this option includes extra data with your scene so be certain that
you need the Selection set data before you export. Exporting a scene with
Selection Sets impacts file size and if Selection Sets are not required, it is good
practice to keep the file size as small as possible by excluding unwanted data.

Convert deforming dummies to Bones

Activate this option to convert geometry used for deforming objects into real
bones in the FBX file.

3ds Max lets you use geometry to deform other geometry (as would bones),
but other applications do not support this kind of deformation.

Why do I need this?

Use this option to keep deformations but convert geometry used as bones into
actual bone objects.

In earlier versions of Maya, you could not use geometry to deform other objects
instead of bones. This option lets users import objects from other software
that had a Use Geometry as Bone option, such as 3ds Max and Softimage into
Maya.

For example, if you had a scene in 3ds Max where a box was used to deform
another box, the geometry as bone object became a proper bone object in
Maya if the Convert Geometry used as Bones option was active. If you disabled
this option, the box would remain a box and there would be no animation.

Maya now supports this type of deformation, so it is no longer necessary to
activate this option. However, it is still a best practice to leave this option
activated for improved interoperability as not all products support geometry
as bones.
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Triangulate

This option automatically tessellates exported polygon geometry.

NOTE This option affects polygon Meshes, not NURBS and Patches.

Preserve edge orientation

This option lets you automatically convert editable poly objects that contain
hidden edge turns to editable mesh objects whenever the plug-in detects them
in the file.

Editable Poly objects in 3ds Max have hidden edges which can be
flipped/turned to change their direction. Because FBX only stores edge visibility
in exported files, not edge orientation, turned edges are lost, and the edges of
editable polys export/import back to 3ds Max with the edges in their
"unturned/unflipped" state. Activating this option means that every time
hidden edges are detected, editable polys always export as editable meshes
(triangulated in the process).

This option is active by default. Disable this setting to stop the automatic
conversion.

Animation

Activate this option to export animation found in the scene.

Expand this option to access advanced animation options and features.

Extra options

Expand Extra options to view additional export options.

Use scene name

Normally, the 3ds Max FBX plug-in saves the 3ds Max scene animation in the
FBX file as Take 001. Activate this option if you want the scene animation to
be named after the 3ds Max scene instead.
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This option is disabled by default.

Remove single key

When you activate this setting, the exporter removes keys from objects on
export if the plug-in determines that the animation has only one key. When
two or more keys exist in the file, the keys are exported.

NOTE

Rotation keys are not affected by this setting.

Disable this option to export every key to FBX, regardless of how many are
found in the animation.

NOTE

This option is disabled by default.

Why do I need this?

Sometimes, a file animation contains a single key that is used as a locator. If
the single key is not needed, activating this option reduces the file size.

Bake animation

This option lets you bake (or Plot) animation at export time.

When you activate this option all unsupported constraints and controllers,
including the 3ds Max Biped, are resampled into animation curves. You can
then import these curves into another application that does not support these
3ds Max constraints.

The plug-in takes the Start and End values automatically from the “timeline”
current settings of the host application. You can modify them by changing
the values once you activate this option.
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NOTE

Bake Animation Start/End/Step values cannot be saved in presets. The 3ds
Max FBX plug-in always derives these values from the scene being exported.
For more, see Preset Bake Animation settings (page 121).

The Step value defines how many keys are created per frame, and has a value
of 1 by default. Setting a Step of 2 for example, only bakes and exports a key
every other frame.

NOTE

The FBX Exporter will bake animation on any objects that have keys on FBX
unsupported channels such as constraints, controllers, and so on.

Resample all

Use the Resample all option to bake even supported animated elements. This
is unlike the Bake animation (page 40) option which selectively bakes
unsupported elements only.

NOTE

The Resample all option resamples animation using the frame rate of the host
application. If you want the Resample all option to use a different frame rate
for sampling, you must specify another frame rate setting in 3ds Max.

The Resample all option reacts to the state of the Bake animation option. If
the Bake Animation option is disabled, the Resample all option is unavailable.

Why do I need this?

The Resample all option is useful if you need to bake or “flatten” the animation
data in the scene.
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Deformations

Activate the Deformations option to access the Skin and Morph deformation
options.

DescriptionOption

Activate this option to export all geometry
Morphs used in your scene.

Morphs

Activate this option to export all Skin de-
formations used in your scene.

Skins

Curve filters

The Curve filters let you apply animation filters to function curves during the
export process.

Constant Key Reducer

Activate the Constant Key Reducer filter to remove redundant keys. Redundant
keys are keys that have the same value, which are equivalent to flat horizontal
interpolations on a curve. Redundant keys are often a result of a resampled
curve.

Before:

After:
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You can set specific thresholds for each type of transform (Transformation,
Rotation, Scaling, and Other. Other includes Morph and custom attribute
curves, for example).

The default values are:

Values represent generic units. This is why you might need to modify threshold
values in relation to the world scale of your scene. This is true for very large
or small scale scenes.

If keys are numerically identical, use very small values to ensure that no
animation is lost.

If you use this filter to eliminate noise, for example, from motion capture
data, then you might need to modify values.

DescriptionSetting

Threshold for translation curves in generic
units.

Translation precision

Threshold for rotation curves in generic
units.

Rotation precision

Threshold for scaling curves in generic units.Scaling precision

Threshold for other curves in generic units.Other precision
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DescriptionSetting

This option ensures that only “auto” key
types are filtered. Otherwise, keys with in-

Auto tangents only

terpolation values greater than a certain
threshold might be deleted.

Unroll rotations

Activate the Unroll Rotations filter to resample rotation curves and give unroll
priority and filter intensity to a specific component, X, Y, or Z.

This filter re-evaluates rotation curves to reduce the number of 180' degree
rotation jumps for a specified component. You can modify or displace these
rotation jumps and/or Gimbal lock with this filter, and not affect the resulting
animation visually.

Before:

After:
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NOTE

The Unroll Rotations filter must resample the entire vector of a rotation curve
(X, Y & Z components). This resampling lets the plug-in find a new path of
values that represent the same rotation.

DescriptionSetting

The precision value affects how the plug-in
re-evaluates the curve and defines the im-
portance given to the unrolled curve.

Filter precision

Activate this option to give priority to the
Y component, normally used for Y-up
scenes.

Follow Y-up

Key Reducer

Activate the Key Reducer filter to reduce the number of keys on animation
curves by setting tangents in order to keep precision of the animation.

You also can use this filter to reduce the number of keys on resampled curves,
which lets you edit keys, not dense data.

Before:

After:
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NOTE

There is always a trade-off between the number of keys needed versus the
precision of the animation. The more keys you have, the more precise the
animation. The fewer keys you have, the easier it is to edit the keys, but there
is less precision.

DescriptionSetting

Generic value. A value of “1” keeps the filter
intensity of the original visual result, in most
cases.

Filter intensity

On X, Y, Z curves, this option adds keys to
other curves (X,Y, or Z) at every added key.

XYZ Curve Synchronization

This setting increases the number of keys.
It also ensures that they always exist on all
three curves of the same vector (X, Y, and
Z) for each key over time.

NOTE

Game engines often require this for real-
time animation playback.

The default values for the Key Reducer filter are a precision value of 1.0 and
the XYZ Curve Synchronization option disabled.
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Point Cache file(s)

Activate this option to create a cache file of a chosen selection set so you can
retain vertex animation data during export. To use this option, you must first
create a selection set of the objects for which you want to retain the vertex
animation in 3ds Max. Use the Selection Set menu to select an appropriate
set to export the cache file.

The stored vertex animation data is stored in a folder in the same location as
the FBX file.

NOTE

You must place the folder wherever the FBX file is placed, so that when an
importer processes the FBX file, it will find the Point Cache data.

What is vertex animation?

Object animation occurs when you move a sphere from one place to another.
If you rotate or scale this object, it is still considered object animation; Any
TRS animation on the object is considered standard object animation and is
what is kept on regular exports.

Vertex animation occurs at the sub-object (vertex) level. For example, if you
were to move 4 vertices on a sphere, this animation is lost on export unless
you create a Point Cache file for this animation.

What is a Point Cache?

A Point Cache is a local sub-object animation of an object. To export this local
sub-object animation from a program like 3ds Max, every vertex position must
be evaluated and stored in a file or series of files called Point Cache files. You
must make a selection set of the object(s) for which to store Point Cache data
because the exporter needs to know for which objects you want the vertex
animation evaluated.

In 3ds Max, you create a Point Cache for your object(s) so you can have better
playback for complex animating. If, for example, you had a scene with 20
controllers driving the animation of 500 different characters, creating a Point
Cache file would let you store all the vertex animation and play it back on all
500 characters, so that 3ds Max does not evaluate the animation controllers
for each character. This in turn, creates a more smooth playback.
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By default, any Point Cache files created are in .MC format. When you activate
this option, three files are generated:

■ an FBX file

■ an XML file

■ an MC file

The 3ds Max FBX plug-in stores the XML and MC files in a subfolder named
after the FBX file and has the suffix FPC (_fpc).

For example, if you export a scene containing a cube named box01 to the FBX
file myTest.fbx, you create the following files and folders:
■ myTest.fbx

■ myTest_fpc

■ box01.xml

■ box01.mc

The plug-in keeps any PC2 or MC Point Cache files that are already recorded
(within the selection set).

Cameras

Activate this option to export all cameras contained in the scene.

The plug-in exports camera settings, and some render settings. Activating the
Cameras option can change rendering results depending on the source
application used in comparison. When you export, 3ds Max cameras are
converted into FBX camera types for interoperability. The plug-in supports
camera settings and converts them. For a list of supported cameras, see Camera
support (page 7).

Lights

Activate this option to export all lights contained in the file. The 3ds Max
FBX plug-in exports and converts light types to ensure FBX interoperability.

The 3ds Max FBX plug-in supports Standard Point, Spot and Directional light
types exported to FBX for Autodesk Maya, Autodesk MotionBuilder, and other
Autodesk applications. For a list of supported lights, see Light support (page
9).

48 | Chapter 5   Export



Embed media

Activate this option to include (or embed) all media associated with your scene
in the FBX file itself. For example, texture images.

When you activate “Embed Media”, the FBX plug-in includes (embeds)
associated media (textures, for example) within the FBX file. The plug-in then
extracts the media to an .fbm folder at import. The plug-in copies the
embedded media to a <fileName>.fbm folder in the same location as the FBX
file and is named after the FBX file. Since this media is contained within the
FBX file itself, this has an impact on file size. Therefore, it is good practice to
use this option only when you transport an FBX file to a location where the
original media source is no longer accessible by the receiver.

NOTE

When you import an FBX file with embedded media, the embedded files
extract to a folder in the same location as the FBX file. If you do not have
write permission to create that new folder, the media files are Imported to the
user's temp folder, such as C:\Documents and Settings\<username>\Local
Settings\Temp.

Why embed media?

If you disable the Embed Media option, the FBX plug-in stores the relative
and absolute paths of the associated media files at export time. This causes
problems if, for some reason, the path is no longer accessible. Make sure that
the associated media is accessible to ensure the proper import of these media
files.

If you export a file to FBX and do not activate the Embed Media option, no
problems occur if you open the file on the same computer and all the images
used in the scene are in the same locations that they were when the file was
exported. However, if you move or delete any texture from that location, and
use the FBX file afterwards, you will get an Importer message stating that you
have missing texture files. This message also appears if you give this FBX file
to someone using a different computer and who does not have that same
texture in that same directory on the same computer drive.

It is a good practice to embed media when you are going to give the FBX file
to another person. It is also a good practice to embed when you use FBX for
storing assets, as you may eventually delete the reference images or move all
the files to another drive or computer with different paths.
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NOTE

You can embed media with ASCII-formatted files, as long as they are exported
to FBX 2011 and later. Versions FBX 2010 and earlier do not support embedded
media in ASCII files.

Advanced options

The Advanced Options rollout primarily contains additional options that let
you modify the default plug-in behavior. In most cases you do not need to
modify these options to have a successful export. The section also holds
additional settings specific to the Collada file type.

Units

The following rollout includes unit settings for your exported files.

Automatic

Activate the Automatic option if you want the 3ds Max FBX plug-in to
automatically identify and set the units of the destination file to match units
of the host application

50 | Chapter 5   Export



When you activate Automatic, the Scene units converted to option is disabled,
although it shows the resolved unit & Scale Factor. If you disable the Automatic
option, the Scene units converted to option becomes available.

When Automatic is active, the File Units will match the system units, and the
plug-in applies no conversion. The displayed Scale Factor is 1.0 in this case.

Scale Factor

Displays the conversion value or Scale Factor that the plug-in applies to the
entire scene during export.

By default, the 3ds Max FBX plug-in uses the system units set in the host
application to determine what units to use to export the FBX file. This means
that the default export Scale Factor is always 1.0, and the plug-in applies no
unit scale conversion during the export process.

You can modify what units the 3ds Max FBX plug-in uses to export your scene
if you change the Scene Units converted to option. If you change the Scene
Units converted to option, you modify the Scale Factor value and units applied
to the exported data.

For information about incorrect or unwanted scaling issues, see Why is my
scene scaled differently in 3ds Max? (page 113).

Scene units converted to:

Use this menu to specify the units to which you want to convert your exported
scene. Modifying this setting directly affects the Scale Factor value applied to
the exported data.

The plug-in determines the default units by looking at the System Unit Scale
in the System Unit Setup dialog box in 3ds Max.

NOTE

To view the default units, click System Unit Setup in the Units Setup dialog
box that appears when you select Units Setup from the 3ds Max Customize
menu.
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On export, the plug-in applies no default scaling since the export and system
units match. This results in a Scale Factor of “1.0”.

For information about incorrect or unwanted scaling issues, see Why is my
scene scaled differently in 3ds Max? (page 113).

Example

If you export a file that is in the same unit setting as the System Units of your
3ds Max scene, there is a match of units and the displayed Scale Factor will
be “1.0”. No scale conversion is applied.

A unit match, with a Scale Factor of 1.0
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Axis conversion

The FBX export plug-ins have two options for Axis Conversion, Y-up, or Z-up.

When you use the Autodesk Media & Entertainment preset, the 3ds Max FBX
plug-in exports using the Y-Up Axis.

You can export your scene to a Z-up axis if the destination application does
not support the Y-up world axis and cannot convert the Y-up world axis of
your scene.

NOTE

The exporter applies Axis Conversions only to root elements of the outgoing
scene. If you have animation on a root object that must be converted on
export, these animation curves are resampled to apply the proper axis
conversion. To avoid resampling of these animation curves, make sure to add
a root node (dummy object) as a parent of the animated object in your scene,
before you export to FBX.

UI

These options let you set display options of the UI, such as show or hide the
Warning Manager.

You can customize these display options, save them as a new Preset, and share
this preset file. See the Edit/Save preset (page 32) section for more information.
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Show/hide Warning manager

This option lets you disable the Warnings and Errors dialog box that appears
during the export process. The Warning manager is active by default.

What is the difference between an Error and a Warning?

The 3ds Max FBX Plug-in uses errors and warnings to alert you of conversions
and potential problems during the export process.

When something unexpected occurs during the conversion, the plug-in reports
an error. An error occurs when the plug-in encounters an unknown behavior
and the conversion is going to produce an unexpected result.

When the plug-in must apply a conversion to the source data for it to be in
a format that the destination application can read, the plug-in reports a
warning. This warning is not the indication of a problem, but is there to
provide a report of conversions that the plug-in has applied to the outgoing
data.

Generate log data

Deactivate the Generate log data option if you do not want warning and error
information written to the log. However, if you deactivate this option, the
FBX Exporter/Importer records the file name and time stamp in the log file,
but does not include error and warning data.

The 3ds Max FBX plug-in stores log files with the FBX presets, in C:\My
Documents\3dsmax\FBX\Logs.

Why do I want to do this?

Occasionally, some batch imports/exports create very large warning/error files,
and in this case you might want to disable this option.

Normally, it is recommended to leave the Generate log data option active,
which is the default, as this helps you identify problems with file conversions.

Log files are important for tracking errors and warnings on export. It is not
recommended to deactivate this option when you export a series of files, for
example, in an automation or batch export because you will not receive any
feedback about any issues that concern files during export. This lack of feedback
can make it difficult to identify problem files which, in turn, makes diagnosing
problems difficult.
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TIP

Because log data is appended to the same log file, after a while the size of this
file become large. It is a good practice to delete the log file after a few exports,
or before processing batch export or import.

FBX file format

This section lets you determine the format of your FBX file.

Type

Save your FBX file as one of these two types, binary or ASCII. While binary is
the normal format for FBX files, ASCII files give you a plain text version of
the file format, which lets you search the file for information retrieval.

FunctionMode

Activate this option to save the FBX file in
the standard format.

Binary

Activate this option to save the FBX file in
ASCII format.

NOTE

If you export your file to ASCII format in
FBX versions 2010 and earlier, you cannot
embed media.

ASCII

Version

Expand the FBX Version menu to select an FBX version.
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The following table lists the different versions available for you to select from
the FBX exporter.

DescriptionVersion

Select this FBX version to export a file that
is compatible with Autodesk 2012 applica-

FBX 2012

tions and 2012 FBX plug-ins. This is the
default FBX version.

Select this FBX version to export a file that
is compatible with Autodesk 2011 applica-
tions and 2011 FBX plug-ins.

FBX 2011

Select this FBX version to export a file that
is compatible with Autodesk 2010 applica-

FBX 2010

tions, 2010 FBX plug-ins and MotionBuilder
2009.

Select this FBX version to export a file that
is compatible with Autodesk 2009 applica-
tions and 2009 FBX plug-ins.

FBX 2009

Select this FBX version to export a file that
is compatible with Autodesk 2006 FBX plug-
ins and MotionBuilder 7.5, 7.0, and 6.0.

FBX 2006

When do I use this?

You do not need to change this option if you are using the latest FBX Plug-ins
in the source and destination applications. You only need to use this option
if you plan to import your file using an older plug-in version.

For example, if you want to export from 3ds Max 2012 and import to 3ds Max
2011 using the latest FBX 2012 versions of the plug-ins in both applications,
you do not need to change the export FBX version. The file is compatible
when you use the FBX 2012 versions of the plug-in.
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Collada

The Collada options only appear when you select the Collada (.DAE) file type
from the file browser when you export.

NOTE

When you export to Collada you are not able to embed textures, even if the
Embed media option is activated. This is because exporting to Collada results
in an ASCII-format file, which does not allow binary information, such as
textures, and so on. See Embed media (page 49)

Triangulate

This option automatically tessellates the exported polygon geometry.

Single matrix

This option ensures that there is only a single animation matrix for each
node/object by baking all animation matrices into one.

Frame Rate

Use this field to set the frame rate of the scene on export.

NOTE

The 3ds Max FBX plug-in now supports Lines and Linestrip nodes.

NOTE

The Smoothing Groups option in the Collada importer does not import
Smoothing Groups from the FBX file. Instead, when you activate this option,
the Importer creates the Smoothing Groups during the import process. The
Collada importer must create Smoothing Groups on Import when this option
is active, because the FBX Collada exporter does not export Smoothing Groups
data from 3ds Max. If you disable the Smoothing Groups option (this is the
default setting), no Smoothing Groups are generated by the Importer.

Advanced options | 57



Information

The Information rollout contains data about the 3ds Max FBX plug-in as well
as buttons you can use to check for more recent versions of the software and
accessing the 3ds Max FBX plug-in Help.

Web Updates

Click the Web Updates button to make sure that you are using the latest
version of the 3ds Max FBX plug-in. This function searches the Autodesk web
site to check if there is a newer version of the plug-in that you are currently
using. See Web updates (page 20)

Help

Click the Help button to launch the 3ds Max FBX plug-in online user
documentation.

NOTE The FBX Help documentation is available from a web site, rather than
installed locally. If you want to install the Help locally, you can download the FBX
help at www.autodesk.com/fbx-help.
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Import

This chapter contains information about options you can use in the 3ds Max FBX
plug-in importer window.

Importing FBX files into 3ds Max
This section describes how to import files using the 3ds Max FBX plug-in:

To import an FBX file:

1 Launch 3ds Max.

2 Select Application Menu > Import, and use the file browser to locate the
FBX file you want to import.

6
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NOTE

If you do not see FBX file extension the File of Type menu, it did not
correctly install or is not the correct version. Check that you have the
correct version of the 3ds Max FBX plug-in and reinstall it. Do not run
3ds Max while you install the plug-in. See Web updates (page 20) for
information on how to verify your plug-in version.

3 The FBX Importer window opens. Set the import options you want.

4 Click Ok.

NOTE To cancel the import process, press ESC.

5 If conversions or errors occur during the import process, the Warning
Manager reports them at the end of the import process. See Show the
Warnings and Errors dialog box (page 82) for information about the
Warning Manager.

NOTE

There is a difference between “Errors” vs. “Warnings”. The plug-in reports
an error when something unexpected occurs. When the plug-in reports
an error, it indicates that the consequences of that error are unknown.
Warnings inform users when the plug-in applies conversions to the
source data to convert the data into a format that the destination
application can read.
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Import presets
The 3ds Max FBX plug-in includes two import workflow presets:

■ Autodesk Media and Entertainment

■ Autodesk Architectural (Revit)

The default preset is based on the application version you are using. If you
use 3ds Max, Autodesk Media and Entertainment is the default preset. If you
use 3ds Max Design, Autodesk Architectural (Revit) is the default preset.

Selecting a preset

You can choose your preset by selecting it in the menu of the FBX Plug-in
“Presets” section.

Editing presets

If you change a preset, the preset field displays User defined, to show that the
preset differs from its default state. You can find the User defined states in a
temporary file so that the settings are the default the next time you use the
plug-in.

You can also use Edit > Save preset to save your settings as a custom preset.
See Creating a custom preset (page 22) and Editing a preset (page 23).
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Autodesk Media & Entertainment preset

The Autodesk Media and Entertainment preset contains the optimal settings
for most animation workflows. All available options are visible in the UI so
you can access and customize them.

Autodesk Architectural (Revit) preset

The Autodesk Architectural (Revit) preset is a simplified version of the FBX
UI. It has optimal settings for architectural workflows translating data from
the Autodesk Revit application, to Autodesk 3ds Max Design. The preset
exposes no options, only the Preset, and Statistics sections. This preset contains
all the basic settings necessary for a Revit to 3ds Max workflow, but you can
edit the preset so that it contains any other settings you require. See Edit/Save
preset (page 63).

In this preset, Animation (page 69) options are disabled, the Smoothing groups
(page 67) option is disabled, the Sun and Sky (page 77) option is activated,
and the File content (page 66) option is set to Add to scene.
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Edit/Save preset

You can use the Edit preset button to create and save custom presets with
option settings that you define.

Access the Edit/Save preset options through the Edit button in the FBX
Importer UI.

The 3ds Max FBX plug-in stores custom presets in a file so you can share them
with other users. For more information, see Storing presets (page 21).
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For more about creating and editing presets, see Creating a custom preset
(page 22) and Editing a preset (page 23).

Statistics
The Statistics window lets you view relevant Meta information about the
incoming (FBX) file and system (application) settings. Information varies
depending on what is in the file.

File name

Displays the name of the file.

File directory

Displays the location of the file directory.

File version

Displays the FBX version of the file.

File creator

Displays the name and version of the application that created the file.
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File creation time

Displays the date and time that the file was created.

File axis direction

Displays the up-axis of the file.

File units

Displays the unit of measurement in the file.

System axis direction

Displays what the up-axis is in the current application.

System units

Displays the unit of measurement used in the current application.

File content

Displays the number of Elements, Textures, Materials, and Caches in the file.

File content area

FPS

Displays the frame rate used (frames per second) in the imported scene and
the application. If the frame rate is not one of the standard rates (24, 25, 30,
48, 50, 60, 100, 120 fps), it is not displayed. For example, an FBX file that uses
a frame rate of 8 frames per second does not display in the Importer statistics.

NOTE If the frame rate does not match between the FBX file and its host
application, a warning appears next to the System Frame Rate value. If the frame
rate is not a standard rate, the Importer displays the system frame rate but no
warning.
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Include

The Include rollout lets you choose what data and conversions to apply to
your scene when you import from a host application.

File content

Use the File content menu to select how to import the content of your file
into the host application. Select from the following three options:

Add

This option adds the content of the FBX file to your scene.

If elements exist in the host application they are duplicated, so use this option
to add non-existing elements to your scene.

This is the default setting for the Autodesk Architectural (Revit) preset.

Add and update animation

This option adds new content and updates animation from your file to
matching objects in your scene.

For example, if there is animation on any object in the FBX file and the object
name is identical to an object in the destination application, that animation
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is replaced. If the object with the same name does not have animation, the
new animation is added

This is the default option for the Media & Entertainment preset.

Update animation

This option adds the content of the FBX file to your scene but only updates
existing animation; any objects in the file that are not already in the scene
are ignored.

Geometry

Expand the Geometry rollout to access options related to importing geometry
into your scene.

Smoothing Groups

Activate this option when you want to retain the Smoothing Groups
information in the imported FBX file. When the FBX file contains no
Smoothing Group data and this option is activated, the plug-in re-evaluates
the geometry and creates Smoothing Groups for all imported geometry based
on the explicit normals data.

Activating this option directly affects performance. This performance loss
occurs because the plug-in must re-evaluate all the geometry.

NOTE

You can use this option when you import Revit-exported or
MotionBuilder-saved FBX scenes, as they contain no Smoothing Group
information, but some Smoothing Groups may not generate properly, and
could potentially cause shading inconsistencies.

This option is disabled by default in the Autodesk Media & Entertainment
preset (page 62). It is also disabled in the Autodesk Architectural (Revit) preset
(page 62).

If the FBX scene already contains Smoothing Group data and this option is
disabled, the 3ds Max FBX plug-in imports only explicit normals data (and
ignores all Smoothing Group information).
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NOTE

There is a limitation that involves explicit normals and Smoothing Groups.
See Importing Explicit normals and Smoothing Groups (page 122) for an
explanation.

When do I use this?

Activating this option is ideal for 3ds Max users who import scenes intending
to use and modify Smoothing Groups information.

NOTE

If your scene contains thousands of objects and you know that you do not
want to work with Smoothing Groups, do not use this option. Otherwise the
3ds Max FBX plug-in must re-evaluate every object during import, which is
time consuming.

If you are a Maya user, the plug-in already exports smoothing information
(Hard/Soft edges). Activating this option usually gives the same visual results
as disabling the option. The difference is the additional Smoothing Group
information/IDs (for example, faces identified as belonging to Smoothing
Group 1, 2, and so on).

Example

For example, if you want to edit the smoothing of objects that come from
Revit, activate this option to create Smoothing Groups when you import. You
can then edit these Smoothing Groups in 3ds Max.

Since Revit has no Smoothing Group data to export, the 3ds Max FBX plug-in
importer must create it. Similarly, Maya also does not export Smoothing Group
data by default. Maya uses Hard/Soft edge information that it directly applies
to geometry normals, unless you activate the Maya FBX Exporter Plug-in
Smoothing Group option, and then Smoothing Groups are generated from
Hard/Soft edge information.

Smoothing Groups and Collada

The Smoothing Groups option in the FBX Collada importer does not import
Smoothing Groups from the FBX file. Instead, when you activate this option,
the Importer creates the Smoothing Groups during the import process. The
Collada importer must create Smoothing Groups on Import because the FBX
Collada exporter does not export Smoothing Groups data from 3ds Max. If
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you disable the Smoothing Groups option, no Smoothing Groups are generated
by the Importer.

Display Layers

The 3ds Max FBX plug-in automatically imports Display layers and does not
appear in the 3ds Max FBX Plug-in user interface. This option imports 3ds
Max Design objects with Object Properties set to By Layer. It imports 3ds Max
objects with Object Properties set to By Object.

NOTE

Layer properties are only supported by layers that are not layer 0; FBX does
not recognize layer 0. For example, if you have objects in Layer 0 and Layer
1, FBX ignores the Layer 0 properties but retains the layer property information
for Layer 1.

The following Display Layer properties are imported:

■ Layer Member List

■ Layer names

■ Display as box

■ Freeze attribute

■ Hide

■ Color

Animation

Activate this option to import animation found in the scene.

Expand this option to access advanced animation options and features.

Extra options

Expand extra options to view additional options for import.
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Animation Take

Displays the current animation take in the FBX file.

If no animation take exists in the file, the field shows a “No animation”
message.

If several animation takes exist in the file, the currently selected take is
displayed in the field.

You can change the selected take of animation by choosing another take from
the menu. The plug-in lists all available takes of animation contained in the
file.

NOTE

You can only select and import a single take of animation at a time.

Fill timeline

Activate this option when you want to update the application Timeline by
the animation range in the incoming FBX file. The term “Animation range”
refers to the first and last keys of animation contained in the file.

Bake animation layers

Bake animation layers lets you bake (or Plot) animation layers contained in
the incoming file.

If your incoming file contains animation layers, make sure that this option is
activated so that the plug-in considers all animation curves. This process bakes
all layers to the base layer and makes them compatible with 3ds Max Curve
editor. This option is Active by default.

If you disable this option, the plug-in imports only the Base (or first) layer of
animation and ignores all additional layers.

If there are no additional animation layers in the file, you can leave this option
active with no effect.
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Optical markers

Activate this option to convert optical markers contained in the file into
dummy objects on import.

If you disable this option, the import process ignores this data.

Optical markers normally come from motion capture data, as a cloud of
animated points or markers. The plug-in does not import the animation as
the data type is incompatible. However, the plug-in converts optical data into
a cloud of static dummy objects in 3ds Max.

NOTE

If your optical data originates from MotionBuilder, you can set the state of all
optical markers to “Done” in MotionBuilder. Setting the markers this way lets
you import the animation data as curves in 3ds Max.

Point Cache file(s)

Activate this option to import FBX-exported Point Cache data during the FBX
import process.

The plug-in generates three files when you export Point Cache files using
FBX:

■ an FBX file

■ an XML file

■ an MC file

The plug-in stores XML and MC files in a subfolder named after the FBX file
and has the suffix FPC (_fpc).

For example, if you export a scene containing a cube named Box01 to the FBX
file myTest.fbx, you create the following files:
■ myTest.fbx

■ myTest_fpc

■ Box01.xml

■ Box01.mc

Include | 71



Deformations

Activate the Deformations option to access the Skin and Morph deformation
options.

DescriptionOption

Activate this option to import all geometry
Morphs contained in the incoming file.

Morphs

Activate this option to import all skin de-
formations contained in the incoming file.

Skins

Curve filters

The Curve filters let you apply animation filters to function curves during the
import process.

Constant Key Reducer

Activate the Constant Key Reducer filter to remove redundant keys. Redundant
keys are keys that have the same value, which are equivalent to flat horizontal
interpolations on a curve. Redundant keys are often a result of a resampled
curve.

Before:

After:
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You can set specific thresholds for each type of transform. T, R, S, and Other.
Other includes Morph and custom attribute curves, for example.

Values represent generic units. This is why you might need to modify threshold
values in relation to the world scale of your scene, for example with extremely
large or small scale scenes.

If keys are numerically identical, use very small values to ensure that no
animation is lost.

If you use this filter to eliminate noise, for example, from motion capture
data, then you might need to modify values.

DescriptionSetting

Threshold for translation curves in generic
units.

Translation filter intensity

Threshold for rotation curves in generic
units.

Rotation filter intensity

Threshold for scaling curves in generic units.Scaling filter intensity

Threshold for other curves in generic units.Other filter intensity

This option ensures that the plug-in filters
only “auto” key types. Otherwise, keys with

Auto tangents only

interpolation values greater than a certain
threshold might be deleted.

The default values are:
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Key Reducer

Activate the Key Reducer filter to reduce the number of keys on animation
curves by setting tangents to keep the animation precision.

You can also use this filter to reduce the number of keys on resampled curves,
which lets you edit keys, not dense data.

Before:

After:
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NOTE

There is always a trade-off between the number of keys needed versus the
precision of the animation. The more keys you have, the more precise the
animation. The fewer keys you have, the easier it is to edit the keys, but the
precision is lost.

DescriptionSetting

Generic value. A value of “1” keeps the
precision of the original visual result, in
most cases.

Filter intensity

On X, Y, Z curves, this option adds keys to
other curves (X,Y, or Z) at every added key.

XYZ Curve Synchronization

The Curve Synchronization setting increases
the number of keys, but ensures that they
always exist on all three curves of the same
vector (X, Y, and Z) for each key over time.
Note: Game engines often require this for
real-time animation playback.

Default values are:

Bone creation

Expand Bone creation to customize the creation of 3ds Max bones.

Use the Bone creation option to choose if you want to create “real” 3ds Max
bones or dummy objects that behave the same way that 3ds Max bones do.
This way you get better visual results.
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You can also use this option to create bone objects that are a specific size. The
plug-in only uses these values on rare occasions when the plug-in does not
compute bone size automatically.

DescriptionSetting

Locks the values entered in the Width and
Height field. (This setting is active only if

Lock width and height

you enter the same value in the Bone Width
and Height fields.)

Select Convert as Dummy to convert joints
or bones into Dummy objects on import.

Convert as Dummy OR Leave as Bones

They resemble bones but do not have the
limitations of a “real” 3ds Max bone. Select
Leave as Bones to convert joints or bones
into “real” or true 3ds Max Bones.

The size of the bone width. (This setting
only affects how the bone looks and does
not affect how it behaves.)

Width

The size of the bone height. (This setting
only affects how the bone looks and does
not affect how it behaves.)

Height

The percentage of the Width or Height (or
thickness) applied to the end or the tip of
the bone.

Taper

Cameras

Activate this option to import all cameras contained in the file.

The plug-in imports camera settings, and some render settings. This can change
rendering results depending on the source application used in comparison.

Cameras are saved as FBX types in the FBX files for interoperability. This means
they must convert into 3ds Max camera types on import. For a list of supported
cameras, see Camera support (page 7).
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Lights

Activate this option to import all lights contained in the file.

FBX supports Standard Point, Spot, and Directional light types from Autodesk
Maya, Autodesk MotionBuilder, and other Autodesk applications.

Photometric light types coming from the Autodesk Revit 2009 (and later)
application into Autodesk 3ds Max Design 2009 (and later) application are
currently supported. For a list of supported lights, see Light support (page 9)

Global Ambient Light

Activate this option to import the ambient color of the FBX file into the scene.

This option is disabled by default and the ambient light is not imported.

Sun and Sky

Activate this option to import FBX exported scenes that contain daylight
systems.

This option is activated by default in the Autodesk Architectural (Revit) preset
(page 62), and disabled by default in the Autodesk Media & Entertainment
preset (page 62).

Advanced options

Use the Advanced Options to customize your general settings and import
process.
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Units

The Units option lets you view the conversion factor (scaling value) the plug-in
uses as well as modify the conversion units.

Automatic

Activate the Automatic option if you want the 3ds Max FBX plug-in to
automatically identify, set, and convert units of the incoming file to match
units of the host application.

When you activate the Automatic option, the Scene Units converted to option
is disabled, although it shows the resolved unit & Scale Factor. If you disable
the Automatic option, the Scene Units converted to option becomes available.

If you activate the Automatic option and the File Units match the system
units, there is no need for scale conversion and the plug-in applies no
conversion. The displayed Scale Factor is 1.0 in this case.

NOTE

This conversion affects only incoming data. This does not change the settings
in 3ds Max.

Scene units converted to

If you disable the Automatic option, you can select your own units with which
to convert the file using the Scene units converted to menu.

For information about incorrect or unwanted scaling issues, see Why is my
scene scaled differently in 3ds Max? (page 113)

Scale Factor

Displays the conversion value or Scale Factor that the plug-in applies to the
entire incoming scene.

The plug-in compares the units used in the host application with the units
used in the file imported to determine the Scale Factor value. The plug-in then
proposes a unit conversion that matches the system units in the host
application. The displayed Scale Factor is the result of this calculation.

This option is always active, but if your file units match the system units, the
plug-in does not need to apply a scale conversion. The plug-in applies no
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conversion. The displayed Scale Factor is 1.0 in this case. You can enhance
import speed and performance when your units match, especially in Revit to
3ds Max workflows.

NOTE

If you change the File Units Converted to option, you can modify the Scale
Factor value applied to incoming data.

For information about incorrect or unwanted scaling issues, see Why is my
scene scaled differently in 3ds Max? (page 113).

File units converted to:

Use this menu to specify the units to which you want to convert the file.
Modifying this setting directly affects the Scale Factor value applied to the
incoming data.

The plug-in determines the default units by looking at the System Unit Scale
in the System Unit Setup dialog box in 3ds Max.

NOTE

To view the default units, click System Units Setup in the Units Setup dialog
box that appears when you select Units Setup from the Customize menu.

The displayed Scale Factor uses this unit setting for its calculation.

This automatic behavior ensures that the plug-in respect the Units, and proper
scaling is applied by default.
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NOTE

Verify the System Units your 3ds Max scene uses so that you can control
whether the plug-in needs to scale your scene. See Why is my scene scaled
differently in 3ds Max? (page 113) for information about the System Units
setup in 3ds Max.

Example

If you import a file that is in the same Unit setting as the System Units of your
3ds Max scene, there is a match of units and the displayed Scale Factor will
be “1.0”. No scale conversion is applied.

If the units do not match and your 3ds Max scene is empty and/or changing
the System Units is not a concern, change the 3ds Max System Units to match
the File Units used in the incoming file before you start to import. This results
in a match of units, Scale Factor of “1.0”, and no scale conversion is applied.

If, for example, you import a file that is in centimeters into a 3ds Max scene
set to inches, with a resulting Scale Factor of 0.3937008. In this case, the
incoming data will be scaled down to match the scene's unit system.

NOTE

If the Scale Factor is 1.0, no scaling is applied. If the Scale Factor is greater
than 1.0, the incoming data is scaled up. If the factor is smaller than 1.0, the
incoming data is scaled down.
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If, with the previous example, you do not want to change the System Units
of your 3ds Max scene and do not want the plug-in to scale your incoming
data, you have another option:

Change the File Units Converted To option to match the File Units. This
results in a Scale Factor of “1.0”, and no scaling is applied, even though units
do not match between the file and the 3ds Max System Units.

NOTE

3ds Max System and Display units are discussed in depth in the
Troubleshooting (page 103) section, see Why is my scene scaled differently in
3ds Max? (page 113).
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UI

These options let you set display options of the UI. This lets you Show or Hide
the Warning Manager and FBX UI windows.

You can customize these display options, save them as a new Preset, and share
this preset file. See the Edit/Save preset (page 63) section for more information.

Show/Hide Warning Manager

This option lets you disable the Warnings and Errors dialog box that appears
during the import process. The Warning Manager is active by default.

What is the difference between an Error and a Warning?

The 3ds Max FBX Plug-in uses errors and warnings to alert you of conversions
and potential problems during the import process.

When something unexpected occurs during the conversion, the plug-in reports
an error. This error occurs because the plug-in encounters an unknown
behavior and the conversion is going to produce an unexpected result.

When the plug-in must apply a conversion to the source data for it to be in
a format that the destination application can read, a warning is reported. This
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warning is not the indication of a problem, but instead exists to provide a
report of conversions that have been applied to the incoming data.

Generate log data

Deactivate the Generate log data option if you do not want warning and error
information written to the log. However, if you do deactivate this option, the
FBX Exporter/Importer does not write log data (such as errors and warnings,)
to the generated log file. However, the file name and time stamp are still
recorded in the log.

The 3ds Max FBX plug-in stores log files with the FBX presets, in C:\My
Documents\3dsmax\FBX\Logs.

Why do I want to do this?

Occasionally, some batch imports/exports create very large warning/error files,
and in this case you might want to disable this option.

Normally, it is recommended to leave the Generate log data option active,
which is the default, as this helps you identify problems with file conversions.

Log files are important for tracking errors and warnings on import. It is not
recommended to deactivate this option when you import a series of files, for
example, in an automation or batch import because you will not receive any
feedback about any issues that concern files during import. This lack of
feedback can make it difficult to identify problem files which, in turn, makes
diagnosing problems difficult.

TIP

Because log data is appended to the same log file, after a while the size of this
file become large. It is a good practice to delete the log file after a few exports,
or before processing batch export or import.
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Information

The Information rollout contains data about the 3ds Max FBX plug-in as well
as buttons you can use to check for more recent versions of the software and
accessing the 3ds Max FBX plug-in Help.

Web Updates

Click the Web Updates button to make sure that you are using the latest
version of the 3ds Max FBX plug-in. This function searches the Autodesk web
site to check if there is a newer version of the plug-in that you are currently
using. See Web updates (page 20)

Help

Click the Help button to launch the 3ds Max FBX plug-in user documentation.

Axis conversion
The FBX importer does not have an Axis Conversion option in the UI. Only
exporters have this option exposed in the UI. This is because the 3ds Max FBX
plug-in calculates and applies the Axis Conversion automatically upon import.
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What does the automatic axis conversion do?

The importer looks at the up-axis used in the host application. In 3ds Max,
this is always Z-up. It then compares this to the up-axis set in the incoming
file. If both up-axes match, the importer applies no conversion. If they do not
match, the importer applies a conversion to the imported data to match the
host application’s up-axis automatically.

When the up-axes do not match, it creates in a longer import process, because
the 3ds Max FBX plug-in must rotate each root object 90 degrees to match
the host application up-axis. This is especially true of Maya or MotionBuilder
to 3ds Max workflows.

NOTE

The importer applies Axis Conversions only to root elements of the incoming
scene. If you have animation on a root object that must be converted on
import, these animation curves are resampled to apply the proper axis
conversion. To avoid resampling of these animation curves, make sure to add
a root node (dummy object) as a parent of the animated object in the source
scene (source application) before you export to FBX.
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3ds Max FBX plug-in
Workflows

Because you can use 3ds Max FBX plug-in for so many purposes, it is difficult to
provide with instruction for every situation.

However, here are a few of the more commonly used workflows:

Revit Architecture to 3ds Max workflow
When you complete the initial design, layout, and modeling of a project in
Revit Architecture, you can use Autodesk® 3ds Max® or Autodesk® 3ds Max®

Design to produce high-end renderings and add final details.
■ 3ds Max is a 3D animation package that provides animation, modeling, and

workflow functionality for complex problems in design visualization and
visual effects.

■ 3ds Max Design is a 3D design visualization solution for architects, engineers,
designers, and visualization specialists. Designed for interoperability with
FBX® files from Revit Architecture, 3ds Max Design preserves model
geometry, lights, materials, camera settings, and other metadata from Revit
projects. With Revit Architecture and 3ds Max Design working together,
designers can extend the building information modeling process to include
design visualization.

NOTE

For simplicity, the following topics refer to 3ds Max Design, but this information
applies to 3ds Max as well.

You can export a 3D view from a Revit project to an FBX file and import it into
3ds Max. You can then create enhanced renderings of the design to share with
clients in 3ds Max.
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The FBX file format passes rendering information to 3ds Max, including lights,
render appearances, sky settings, and material assignments for the 3D view.
By preserving this information during the export process, Revit Architecture
maintains a high degree of fidelity and reduces the amount of work required
in 3ds Max.

NOTE

There are some limtations created with Revit. For information on why these
limitations occur and how to address them, see Troubleshooting and
Limitations (page 103).

Exporting from Revit Architecture to 3ds
Max Design

1 In Revit Architecture, open a 3D view, and prepare it for export.

2 Click File menu > Export > FBX.

NOTE

If this menu option displays as gray, open a 3D view of the project. Then
try the menu option again.

3 On the Export dialog, for Save in, navigate to the target folder for the
exported file.

4 For Naming, do one of the following:
■ To specify a file name manually, select Manual (Specify file name).

For File name/prefix, specify the name of the output file.

■ To use an automatically generated file name, select Automatic – Long
(Specify prefix), or Automatic – Short.

5 Click Save.

Revit Architecture generates the FBX file and saves it in the target
location.

You can now import the FBX file into 3ds Max, using the 3ds Max FBX
Plug-in.

6 In 3ds Max Design, Click File > Import, and select the FBX file you want
to import, and Click OK.

7 In the 3ds Max FBX plug-in, make sure that the Autodesk Architectural
(Revit) preset (page 62) is the selected preset.
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8 Click OK in the FBX UI window, and your FBX is imported.

You can download a high level that details FBX 3ds Max Design
interoperability.

NOTE

Revit 2011 FBX files are fully compatible with only 3ds Max and 3ds Max
Design 2011. When you import Revit 2011 FBX files into 3ds Max 2009 or
2010, lights, materials, RPCs, and environments are lost; only cameras and
geometry are imported. If you are using Revit 2010/2009 FBX files, use 3ds
Max version 2009 or later.

IFFFS
The following section is relevant for Autodesk Inferno, Autodesk Flint,
Autodesk Flame, Autodesk Fire, and Autodesk Smoke (IFFFS) products.

Importing and Exporting Cameras.

You can either create or import a camera from an FBX file, then edit this 3D
camera in IFFFS. You can then export this camera with animation to an FBX
file so you can import this camera into a 3D application, such as 3ds Max,
Maya, or MotionBuilder.

Flame Cameras

Flame supports the import and export of 3D data saved in the FBX format.
The FBX format provides a way to exchange 3D data for scene
compositions—such as cameras—between tools and packages developed by
different manufacturers.

To export a camera to FBX format:

1 In Flame, select the camera you want to export.

2 In the Object menu, select the Camera menu and click Export. The Export
Camera file browser appears

3 Make sure FBX is selected in the Export Type box.
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4 Select which elements of the FBX files you wish to export by clicking
the corresponding filter button.

DescriptionElement

Rotate the exported camera by -90° on
the X-axis so that it is compatible with

Rotate Axis

the coordinate system of the 3D applic-
ation.

Export the animated axes present in the
Action scene.

Export Axes

Export the 3D-point cloud created by
the 3D Tracker.

Export Point Cloud

5 Navigate to the location where you want to export the FBX file.

6 Enter a name for your FBX file in the file field.

7 Click Save.

One-click workflows
FBX technology drives the Autodesk one-clickworkflow.

One-click workflow texture location

Textures in files that use the one-click workflow process are stored in the
following location (unless otherwise specified).

Maya default :

C:\Documents and Settings\<username>\My
Documents\maya\projects\default\textures\myscene-files\..

3ds Max default:

C:\Documents and Settings\<username>\My
Documents\3dsMax\sceneassets\images\myscene.max-files\..

NOTE Unnamed scenes produce an "untitled-files" folder. This untitled-files folder
is re-used and overwritten for each unnamed scene.
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Scripting for the 3ds
Max FBX plug-in

This chapter contains the commands for scripting 3ds Max FBX plug-ins. The 3ds
Max FBX plug-in must be loaded before you run any script commands with
MAXScript, otherwise an error message occurs.

If you use a MAXScript FBX command in the MAXScript listener when the 3ds Max
FBX plug-in is not loaded, commands are ignored even if you load the plug-in
afterward.

NOTE

When you export or import files in MAXScript, use the command #noPrompt to
prevent the FBX Exporter/Importer user interface from appearing during the process.
For example: ImportFile "C:\test.fbx" #noPrompt. If the UI appears before an export
or import command executed through MAXScript, the last used preset is chosen,
and effectively ignores any recent scripted changes.

Loading the FBX plug-ins
You can load the FBX plug-ins two ways, manually and using MAXScript.

Loading the 3ds Max FBX plug-in manually

1 Start 3ds Max.

2 Go to the main menu and select Customize > Plug-in Manager.

3 Locate the FBXMAX.DLU name in the list box, right-click it, and choose
Selected Plug-ins > Load.
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Loading the 3ds Max FBX plug-in using
MAXScript

Run the following scripts to load the FBX plug-ins through MAXScript:

FBX Importer

pluginManager.loadClass FBXIMPORTER

FBX Exporter

pluginManager.loadClass FBXEXPORTER

NOTE

The 3ds Max FBX plug-in must be loaded before you run any script commands
with MAXScript, otherwise an error message occurs.

Scripting commands
Use these script commands to list, query, or set FBX I/O Settings properties
for the 3ds Max FBX plug-in, even properties created with a plug-in extension.

DescriptionCommand

Use this command to list all the import
properties available with path, type, and
the specified value.

FBXImporterGetParam "FBXProperties"

Use this command to list all the export
properties available with path, type, and
the specified value.

FBXExporterGetParam "FBXProperties"

Use this command to set an import value
to true.

FBXImporterSetParam "Import|Include-
Grp|Animation|Markers" true
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DescriptionCommand

Use this command to set an export value
to true.

FBXExporterSetParam "Export|Include-
Grp|LightGrp|Light" true

Use this command to query an import
value.

FBXImporterGetParam "Import|IncludeGrp|
LightGrp|Animation|Markers"

Use this command to query an export value.FBXExporterGetParam "Export|Include-
Grp|LightGrp|Light"

All script commands and paths in this section are case sensitive, so it is good
practice to copy and paste these commands so you have the exact path for
the IOSettings when querying for a list of properties and their path.

NOTE

These script commands support only Integer, Double, Bool, and Enum
properties

FBXExporterGetParam [arg]
The getparam scripts queries the export plug-in parameters where [arg] is a
recognized export parameter.

FBXExporterGetParam returns the value of the named parameter. If the
parameter is unrecognized or the wrong number of arguments are provided,
the value "unsupplied" is returned.

For a list of supported parameters, see FBXExporterSetParam [arg] [value] (page
93).

FBXExporterSetParam [arg] [value]
The setparam scripts set the specified argument for export where [arg] is a
recognized export parameter and [value] is an appropriate value for the
supported parameter. For example, to prevent the export of cameras:

FBXExporterSetParam "Cameras" false
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"FBXExporterSetParam" returns "OK" if successful or "unsupplied" if it is sent
an unrecognized parameter.

"FBXExporterSetParam" returns "unsupplied" if the wrong number of arguments
are passed.

"FBXExporterSetParam" recognizes the following parameter and values:

ValueName

True or false. See Animation (page 39) for an explanation of this
setting.

"Animation"

True or false. See Type (page 55) for an explanation of this setting."ASCII"

"None", "Animation", or "Fbx_Root". See Axis conversion (page
53) for an explanation of this setting.

"AxisConversionMethod"

True or false. See Bake animation (page 40) for an explanation of
this setting.

"BakeAnimation"

Integer value. See Bake animation (page 40) for an explanation
of this setting.

"BakeFrameStart"

Integer value. See Bake animation (page 40) for an explanation
of this setting.

"BakeFrameEnd"

Integer value. See Bake animation (page 40) for an explanation
of this setting.

"BakeFrameStep"

True or false. See Resample animation (page 41) for an explanation
of this setting.

"BakeResampleAnimation"

True or false. See Cameras (page 48) for an explanation of this
setting.

"Cameras"

True or false. See Triangulate (page 57) for an explanation of this
setting.

"ColladaTriangulate"
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ValueName

True or false. See Single matrix (page 57) for an explanation of
this setting.

"ColladaSingleMatrix"

Float (in frames). See Triangulate (page 57) for an explanation of
this setting.

"ColladaFrameRate"

True or false. This converts non-TIFF-formatted texture images
into TIFF format which makes them readable in other applications
that do not support other image types.

"Convert2Tiff"

"mm" or "cm" or "dm" or "m" or "km" or "in" or "ft" or "mi" or
"yd". See Scene units converted to: (page 51) for an explanation
of this setting.

"ConvertUnit"

True or false. See Embed media (page 49) for an explanation of
this setting.

"EmbedTextures"

"FBX201200" or FBX201100" or "FBX201000" or "FBX200900"
or "FBX200611". See FBX version (page 55) for an explanation of
this setting.

"FileVersion"

True or false. See Constant key reducer (page 42) for an explana-
tion of this setting.

"FilterKeyReducer"

True or false. See Convert Geometry used as Bones (page 38) for
an explanation of this setting.

"GeomAsBone"

True or False. See Generate log file (page 54) for an explanation
of this setting.

"GenerateLog"

True or false. See Lights (page 48) for an explanation of this set-
ting.

"Lights"

"x" where x is the name of the preset file. See Export presets (page
30) for an explanation of this setting.

"LoadExportPresetFile"

FBXExporterSetParam [arg] [value] | 95



ValueName

True or false. See Split per-vertex Normals (page 35) for an ex-
planation of this setting.

"NormalsPerPoly"

True or false. See Point cache file(s) (page 47) for an explanation
of this setting.

"PointCache"

This setting preserves the current state of the settings when you
perform a One-Click operation. FBXExporterSetParam "PopSet-
tings" loads all I / OSettings.

"PopSettings"

True or false. See Preserve Instances (page 37) for an explanation
of this setting.

"Preserveinstances"

This setting preserves the current state of the settings when you
perform a One-Click operation. FBXExporterSetParam "PushSet-
tings" saves all I / OSettings.

"PushSettings"

True or false. See Remove single keys (page 40) for an explanation
of this setting.

"Removesinglekeys"

Float. See Unroll rotations (page 44) for an explanation of this
setting.

"Resampling"

Loads the Autodesk Media & Entertainment export preset."ResetExport"

Float. See Scale Factor (page 51) for an explanation of this setting."ScaleFactor"

Name of the selection set to use. See Point cache file(s) (page 47)
for an explanation of this setting.

"SelectionSet"

True or false. See Selection Sets (page 37) for an explanation of
this setting.

"SelectionSetExport"

True or false. See "Morphs" in Deformations (page 42) for an ex-
planation of this setting.

"Shape"
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ValueName

True or false. See "Skin" in Deformations (page 42) for an explan-
ation of this setting.

"Skin"

True or false. See Show/Hide Warning Manager (page 54) for an
explanation of this setting.

"ShowWarnings"

True or false. See Smoothing Groups (page 34) for an explanation
of this setting.

"SmoothingGroups"

True or false. See TurboSmooth (page 37) for an explanation of
this setting.

"SmoothMeshExport"

True or false. See Tangents and Binormals (page 36) for an explan-
ation of this setting.

"TangentSpaceExport"

True or false. See Triangulate (page 39) for an explanation of this
setting.

"Triangulate"

"Y" or "Z". See Axis conversion (page 53) for an explanation of
this setting.

"UpAxis"

True or false. See Use scene name (page 39) for an explanation
of this setting.

"UseSceneName"

For example, to query the export camera’s state:

FBXExporterGetParam "Cameras"

Export selected

A specific MAXscript exists for performing the export of only selected objects
("Export Selected"). Use the following

exportFile "<path>" #noPrompt selectedOnly:true

Where <path> is the location to where you want to export your object(s).
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FBXImporterGetParam [arg]
The getparam script queries the import plug-in parameters where [arg] is a
recognized import parameter.

"FBXImporterGetParam" returns the value of the named parameter. If the
parameter is unrecognized or the wrong number of arguments are provided,
the value "unsupplied" is returned.

For a list of supported parameters, see FBXImporterSetParam [arg] [value] (page
98).

FBXImporterSetParam [arg] [value]
The setparam script sets the specified argument for import where [arg] is a
recognized import parameter and [value] is an appropriate value for the
supported parameter.
■ "FBXImporterSetParam" returns "OK" if successful or "unsupplied" if it is

sent an unrecognized parameter.

■ "FBXImporterSetParam" returns "unsupplied" if the wrong number of
arguments are passed.

FBXImporterSetParam recognizes the following parameter and values:

ValueName

True or false. See Animation (page 69) for
an explanation of this setting.

"Animation"

True or false. See Axis conversion (page 84)
for an explanation of this setting.

"AxisConversion"

True or false. See Bake animation layers
(page 70) for an explanation of this setting.

"BakeAnimationLayers"

True or false. See Cameras (page 76) for an
explanation of this setting.

"Cameras"
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ValueName

"mm" or "cm" or "dm" or "m" or "km" or
"in" or "ft" or "yd". See File units converted

"ConvertUnit"

to: (page 79) for an explanation of this set-
ting.

True or false. See Fill timeline (page 70) for
an explanation of this setting.

"FillTimeline"

True or false. See Constant key reducer
(page 72) for an explanation of this setting.

"FilterKeyReducer"

True or false. See Key Reducer (page 74)
for an explanation of this setting.

"FilterKeySync"

True or False. See Generate log file (page
83) for an explanation of this setting.

"GenerateLog"

True or false. See Bones (page 75) for an
explanation of this setting.

"ImportBoneAsDummy"

True or false."KeepFrameRate"

True or false. See Lights (page 77) for an
explanation of this setting.

"Lights"

"x" where x is the location of the preset file.
See Import presets (page 61) for an explan-
ation of this setting.

"LoadImportPresetFile"

True or false. See Optical markers (page 71)
for an explanation of this setting.

"Markers"

#create (Add) #exmerge (And and Update
Animation) #merge (Update animation).

"Mode"

See File content (page 66) for an explana-
tion of this setting.
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ValueName

This setting preserves the current state of
the settings when you perform a One-Click

"PopSettings"

operation. This setting loads all settings
saved by FBXImporterSetParam "PushSet-
tings".

This setting preserves the current state of
the settings when you perform a One-Click
operation. This setting saves all I/O settings

"PushSettings"

True or false. See Point cache file(s) (page
71) for an explanation of this setting.

"PointCache"

Float."Resampling"

Restores factory defaults. If ResetImport is
called without argument for:

"ResetImport"

■ 3DS Max: Loads the Autodesk Media
& Entertainment import preset.

■ 3DS Design: Loads the Autodesk Ar-
chitectural (Revit) import preset

Using the file name only as the argu-
ment: If we pass "Autodesk Media & Enter-
tainment.fbximportpreset" or "Autodesk
Architectural (Revit) .fbximportpreset", it
searches the factory preset directory to load
the preset file.
Use this command to load a factory preset
without knowing the directory.

NOTE This command is used by the
OneClick functionality.

True or false. See Units (page 78) for an
explanation of this setting.

"ScaleConversion"
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ValueName

Float. See Scale Factor (page 78) for an ex-
planation of this setting.

"ScaleFactor"

True or false. See Deformations (page 72)
for an explanation of this setting.

"Shape"

True or false. See Deformations (page 72)
for an explanation of this setting.

"Skin"

True or false. See Smoothing groups (page
67) for an explanation of this setting.

"SmoothingGroups"

This parameter is only available for the "get"
function.

"TakeCount"

An integer number from 1 to the number
of takes in the FBX file. This parameter is

"TakeIndex"

only available for setting. When you specify
the take, use 0 to indicate no animation.
(This is the default value of this property.)
Use 1 to specify the first take in the FBX file,
2 to indicate the second take, and so on.
See Animation Take (page 70) for an explan-
ation of this setting.

"Y" or "Z". See Axis conversion (page 84)
for an explanation of this setting.

"UpAxis"

For example, to import an FBX file using the Add and Update scene elements
mode and the skin modifier, but without loading animation FCurves:

FBXImporterSetParam "Mode" #merge
FBXImporterSetParam "Skin" true
FBXImporterSetParam "Animation" false
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Troubleshooting and
Limitations

Because FBX technology is supported by so many software applications, it is inevitable
that occasional problems will occur or some details will not yet have attained perfect
support.

Occasionally, the default settings of the plug-in do not respect a particular workflow,
or the conversion process creates conflicts between two packages with similar but
not identical functions. Sometimes a file is exported correctly but becomes
inexplicably larger, or the assets in the file are no longer in the same location as they
were before conversion.

This section contains a troubleshooting guide for problems with the import or export
process as well as contains details on known limitations for the 3ds Max FBX plug-in.

Troubleshooting
This section contains descriptions of some advanced problems, explains why
they occur, and if available, offers workarounds.

If none of the topics in the Troubleshooting or Limitations section help you,
search the . The forums contain ongoing discussion about the 3ds Max FBX
plug-in, as well as an e-mail address where you can contact support and alert
the FBX team to your issues.

What happened to my textures?

Textures disappear from files if you move or delete any textures from the relative
and absolute paths of the associated media files location. This can happen when

9
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you give the FBX file to someone using a different computer who does not
have that texture in that directory on your computer drive.

Use the Embed media (page 49) option to make the FBX plug-in include
(embed) associated media (textures, for example) within the FBX file. The
plug-in then extracts the media to an .fbm folder at import. The plug-in copies
the embedded media to a <fileName>.fbm folder in the same location as the
FBX file and is named after the FBX file.

NOTE

When you activate Embed Media, the media is contained within the FBX file
itself, and this has an impact on file size. It is good practice to use this option
only when you transport an FBX file to a location where the original media
source is no longer accessible by the receiver.

If you disable the Embed Media option, the FBX plug-in stores the relative
and absolute paths of the associated media files at export time. This causes
problems if, for some reason, the path is no longer accessible. Make sure that
the associated media is accessible to ensure the proper import of these media
files.

Embed Media is active, but I still do not see my textures

In previous versions of the 3ds Max FBX plug-in, when you saved an FBX file
with the Embed Media option activated, the embedded files were extracted
to a folder in the same location as the FBX file. If you did not have write
permission for the folder, then the media files were not extracted. You can
experience this lack of write permission when you work over a network.

With the current version of the 3ds Max FBX Plug-in, if you do not have write
permission for the folder creation, the media files are sent to a temp folder
instead. See Embed media (page 49).

NOTE

If you export your file in ASCII format using FBX versions 2010 and earlier,
no textures can be embedded.

Why are my textures mapped incorrectly?

You will get incorrect texture mapping when you import objects into 3ds Max
Design that meet the following conditions:
■ Objects are created in 3ds Max Design with the Real-World Map Size (UV

Mapping) option activated
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■ Materials have the Use Real-World Scale (Bitmap Coordinates rollout)
option disabled

■ UV Tiling is set to anything other than 1.0.

If you have objects that fit all these criteria you will have mapping issues when
importing into 3ds Max Design because the imported materials reset the
Real-world Scale option back to On. This inconsistency occurs because 3ds
Max Design has different defaults from 3ds Max.

To compensate for this, once the file is imported into 3ds Max Design, disable
Real-world Scale in the Material Editor Bitmap Coordinates rollout.

Poser-created Collada (DAE) files in Maya

Files lose their texture maps if you import Collada (DAE) files created in Poser.
When the FBX plug-in encounters this limitation the Missing Map Files dialog
box appears when you render. This is because 3ds Max cannot locate the files.

You can address this if you add the location to the External Files path list.

To keep textures visible:

1 In 3ds Max, click Customize > Configure User Paths.

The Configure User Paths dialog box appears.

2 Select the External Files tab and click Add.

3 Navigate to the location of the texture files in the Choose New External
Files Path dialog box.

4 Click Use Path.

When you render your file, the texture maps are shown.

For a description of this limitation, see Missing texture maps in DAE files (page
126).

Why does My Mudbox model render
incorrectly?

If you are exporting a mesh that has been used as the source in a texture map
extraction (for example, if you used this model as the source to extract a
displacement map), be aware that any extracted texture maps are automatically
exported with your model.
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This can result in unexpected deformation when you import the model into
another application, as the texture maps are automatically assigned to the
model on import. If you experience this issue, you can remove any unwanted
texture map from the associated channel (such as the displacement or bump
channel) after importing the model.

Why is my file so much larger?

Sometimes when you export a file from Revit, the file size dramatically
increases. For example, a 30 mb Revit file can become 60 mb on export to
FBX.

Why does this happen?

The original Revit file size is smaller because it contains less data than an FBX
file. Revit scene file information accesses much scene information from libraries
that reside within the Revit software, for example, Revit-specific construction
data and textures. This information that is normally read from the Revit
software now must be added on top of the FBX file on export so it can be
reproduced accurately by software that cannot access Revit libraries.

This over-sizing problem also occurs with 3ds Max (.max) files on export for
the same reason. A .max file must contain only the instructions that 3ds Max
requires to create the scene. Materials and lighting information is read directly
from the 3ds Max software libraries.

On top of this, when the Revit or 3ds Max file becomes an FBX file, it is
converted to complex FBX scene information based on geometric data, such
as vertex coordinates, UVs, and so on. This way, the FBX file contains the
actual geometric data so it can be read in any software that supports the FBX
format.

File sizes also tend to grow between Revit and FBX because all material data
is embedded with the FBX file. The growth in file size means FBX files must
contain every Revit texture used as materials so you can later import the FBX
file into 3ds Max. A Revit scene file does not need to contain any texture files
because the textures reside in the Revit software, where the scene file can refer
to them.

Occasionally, large files do not import properly into 3ds Max due to memory
constraints. If a file contains a massive amount of metadata and geometry,
the import process can take hours.
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Working with large files

There is also a known issue that affects few users when an extremely large FBX
file is imported.

If you switch the 3ds Max System (not Display,) units to feet, so they match
the Revit Imperial units exported to FBX, the import process takes much less
time to complete. The unit conversion process is a complicated one for the
FBX Importer and takes a long time to complete. Matching the units between
an FBX file and the host program is often the deciding factor whether or not
a large FBX file imports successfully into 3ds Max.

For more about System Units conversion problems, see Why is my scene scaled
differently in 3ds Max? (page 113).

Why is the geometry offset?

Geometry exported from Revit does not have a correct local pivot point or
center, as is normal when you create objects in 3ds Max. Object centers are
offset from the object, but have a correct position in global space. If you are
not manipulating or animating the position of your objects in 3ds Max, this
offset has no impact.

Why are my objects offset?

Objects can lose some transformation data when they have local axes that are
not perpendicular to each other (non-orthogonal). This is due to a limitation.
See Non-orthogonal matrices (page 121).

Why are edges visible on my models?

Visible edges are hidden lines that are normally invisible in 3ds Max. The
problem typically occurs with Revit models because everything exported from
Revit is triangulated. This causes edges that 3ds Max would normally hide to
become visible.
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NOTE

This visible edge problem applies if you export from Revit version 2010 and
earlier. This problem has been addressed for Revit 2011, so as of that version,
objects now export with hidden edge information.

What are visible edges?

You can recognize a visible edge, for example, if you have a wall in Revit that
should only be represented in 3ds Max with four edges which are the four
sides of the wall. Instead, 3ds Max displays the middle triangle that connects
both corner vertices. This middle triangle is normally hidden.

Use this script to hide any unwanted edges from imported models, typically
Revit version 2010 and earlier models loaded in 3ds Max using FBX. The script
will read all edges and determine which ones can be hidden by evaluating
whether they are next to any neighboring edges. Hiding these unwanted edges
makes the model much easier to view.

To use this script:

1 Select all objects in the scene.

2 Select MAXScript > New Script in the 3ds Max main menu.

3 Copy and paste the script below into the dialog.

4 Press CTRL-E to Evaluate All and run the script.

You can also save this script in 3ds Max and drag and drop the .ms file in the
Viewport while objects are selected.

NOTE

This script works only for editable meshes, and ignores editable polys, patches,
or other entities.

(
-- do this in a local scope so I don't pollute the global
scope.
function setVisibilityEdges obj =
(
local edgeSelSet = #()
-- Go through all faces
local numFaces = obj.numfaces
for faceIndex = 1 to numFaces do
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(
-- And for every one of the 3 edges
for edgeIndex = 1 to 3 do
(
--collect the edge
append edgeSelSet ( ((faceIndex-1)*3) + edgeIndex )
)
)
-- Select all visible edges
meshop.autoedge obj edgeSelSet 5 type:#setclear
)
--==============================================
-- Start of the runtime script
--==============================================
local timestart = timestamp()
-- turn off undo during this operation.
with undo off
(
local editMeshArray = #()
for obj in Selection do
(
if (classof obj == Editable_Mesh) do
(
-- collect all the edit meshes first, because the
-- user could have selected some helper objects too,

which we
-- don't want to process.
append editMeshArray obj
)
)
-- we don't need to hold the selection anymore, clear it
out.
clearselection()
-- Array of object handles that have already had their

edges hidden
local allReadyProcessed = #()
-- iterate through all selected edit meshes...
for editMeshobj in editMeshArray do
(
local found = (FindItem allReadyProcessed

editMeshobj.handle) > 0
if (not found) then
(
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setVisibilityEdges editMeshobj
append allReadyProcessed editMeshobj.handle -- Mark

all the instances as processed too!
InstanceMgr.GetInstances editMeshobj &repeatArray
if (repeatArray.count > 0) then
(
-- mark them as processed by adding their handle to

the array
for repeat in repeatArray do
(
append allReadyProcessed repeat.handle
)
)
)
)
)
redrawviews()
local timeend = timestamp()
format "Total time: % (seconds)\n" ((timeend -
timestart)/1000.0))

Why are my Revit lights reoriented on
import?

If your exported Revit IES lights have incorrect tilt angles or incorrect IES Web
Distributions orientation in 3ds Max, this is due to a known issue.

This problem occurs in Revit version 2011 and earlier importing to 3ds Max
version 2011 and earlier. You can find a fix for this problem in Revit 2011
UR1 and 3ds Max 2011 SP1.

Click Autodesk Revit Architecture Services & Support to go to the Revit Updates
page.

Click Autodesk 3ds Max Services & Support to go to the 3ds Max Updates &
Service Packs page.
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Why does it take so long for my Revit file
to import or export?

Performance may be slow for large projects that contain many objects and
data when exporting from Revit Architecture and importing into 3ds Max.

To improve performance, limit the model geometry you export. Try using a
section box or hide categories of model elements that you do not need in
Revit Architecture and set an appropriate level of detail level.

If the FBX Importer does not perform unit conversion, such as switching 3ds
Max to Feet, the import process is much faster. See Working with large files
(page 107).

Where are my Revit cameras?

Revit Architecture exports only one camera to FBX, which corresponds to the
active 3D view. This means only the current Revit 3D view or camera imports
into 3ds Max as a 3D camera view.

Why are my Revit cameras different after
import and export?

The 3ds Max FBX plug-in does not support the cropping region and optical
center of Revit cameras. However, the field of view (FOV) or perspective of
the Revit cameras is correct in 3ds Max. So, this does not translate precisely
in 3ds Max if you modify your Revit camera by resizing and/or offsetting the
cropping region (frame) of your 3D view in Revit.

This is caused by a combination of FBX not transporting the render resolution
settings, and a limitation that the 3ds Max camera model does not support
an optical center

Where are my Revit Massing objects?

Massing objects in Revit are not supported, and do not export to FBX.
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Why are Revit objects hidden or missing?

In Revit, you can “hide” and “temporarily hide” elements. The 3ds Max FBX
plug-in imports “temporarily hidden” objects exported from Revit. Although
they exist, these elements are not visible in 3ds Max, since they are “hidden”.

“Hidden” elements in Revit do not export and do not exist when you import
your FBX into 3ds Max.

Where are my Revit groups?

Revit Groups have no 3ds Max equivalent so the 3ds Max FBX plug-in ignores
all Revit Groups. For example, if you export lights within a Revit Light Group,
the 3ds Max FBX plug-in converts the lights but loses any grouping.

What is Revit's internal unit system?

Revit calculates system units in Imperial units (Feet and Fractional Inches).
When Metric units are set as the “Project Units”, Revit dynamically converts
the Imperial units into Metric units, in the UI. This means that FBX always
exports in the actual system units, Imperial (Feet). There are no issues in
working with Metric units in Revit and 3ds Max, but this results in an Imperial
(Feet) FBX file, that automatically converts to Metric (Meters) on FBX import
into 3ds Max. When you use an Imperial (Feet) Project Unit in Revit and Feet
System Units in 3ds Max, no conversion is needed.

For more on Revit units, see Why is my scene scaled differently in 3ds Max?
(page 113).

Where are my Revit Daylight Portals?

Revit uses daylight portals differently from 3ds Max. They exist in both
applications but because they are calculated differently when you render, 3ds
Max FBX plug-in does not import these daylight portals into 3ds Max. Doing
so would result in low performance. This performance issue is because Revit
systematically creates daylight portals for each individual window, and for
each side of the window. This does not affect the rendering performance of
Revit since only windows relevant to the camera view are only calculated
when you render.
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However, 3ds Max renders all daylight portals systemically. Therefore, it is
better to create one single daylight portal for an entire wall of windows
manually in 3ds Max as you would normally when you work in 3ds Max. This
results in better performance and gives better visual results.

Why is my scene scaled differently in 3ds
Max?

3ds Max has two unit settings, System and Display, that can create conflicts
when you try to exchange data between 3ds Max and MotionBuilder, Maya,
or Revit.

If they are set differently (for example, inches and centimeters), the 3ds Max
System and Display units settings do not create issues as long as you are only
working within 3ds Max. However, MotionBuilder and Maya use centimeters,
and Revit uses feet/meters, so conversions might occur each time an FBX file
is moved between those programs.

Generally in 3ds Max, changing the System Unit Setup is discouraged as it
can create confusion. But for the purposes of file exchange and interoperability,
altering 3ds Max System Units is necessary as FBX files do not take 3ds Max
Display units into account. Consult the following sections for a detailed
explanation of the scaling problem.

MotionBuilder and Maya scaling

Unlike 3ds Max, which uses inches as its base system unit, MotionBuilder and
Maya both use centimeters. To compensate for this, 3ds Max users are generally
instructed to switch their Display units to centimeters, and leave the default
system units setting (inches) unchanged. This creates problems when
exchanging files between other software applications.

For example, if you export a 3ds Max object when you have your Display units
set to one measurement (such as centimeters), and your System Units set to
another measurement, the FBX exporter only considers the 3ds Max System
Units, even if they differ from the Display units.

This becomes more complex if you then save the FBX file in MotionBuilder
and import it back into 3ds Max. The FBX Importer evaluates the 3ds Max
System Units, but once you save the FBX file in MotionBuilder, it is converted
to centimeters. The FBX Importer accordingly converts the incoming FBX file
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to match the 3ds Max System Units. This now scales your object even though
you had no expectation of scaling because your Display units have always
been in centimeters.

If you want to exchange FBX files between 3ds Max and MotionBuilder, change
your System Unit settings to centimeters to match. If you want to exchange
FBX files between 3ds Max and Maya, change your 3ds Max System Unit
settings to match the Maya Working units.

Revit scaling

Similar issues occur with Revit as Revit System Units are Feet/Meters and 3ds
Max System Units are inches by default. If you import an FBX file from Revit
that uses “Imperial: Feet” as system units into 3ds Max while the 3ds Max
default units are inches, the FBX conversion scales all objects in the scene
during the import process.

The Revit scale is 12.0 (or 12 inches per foot). This is because, if the scaling
did not occur, your units would become one foot = one inch which would
then create distortion in any bitmap used in the scene.

For example, if you do not scale objects upon import, a Revit imported house
ends up with walls that are 12 inches long, instead of 12 feet long. The FBX
conversion scaling is also done to ensure that bitmaps are mapped properly
in size in relation to the objects in the scene. If your wall is 12 feet long, it
has to be converted to 144 inches long for the bitmap used to display in an
appropriate real-world scale.

If you want to exchange FBX files between 3ds Max and Revit, change your
System unit settings to feet to match Revit.

NOTE

We do not recommend that you change the FBX Revit Import preset Units
setting in the so that the scale units are feet instead of inches. It is true that
if you do this, you create a 1:1 match for objects and avoid any scaling
conversion. However, if you change the Revit Preset units setting so that no
conversion is performed, all units become non-real-world and then materials
do not render at the right scale.

Revit workaround

If you do not want to change the 3ds Max default System Units, there is
another work-around for this scaling problem; manually convert every object
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to real world scale after you import the file into 3ds Max. If you do this, you
must have Inches set as system units, which is the 3ds Max default.

1 Import your FBX file into 3ds Max Design using Inches as System Units.

2 Select any of the objects in the scene and verify their scale: 1200%

3 Apply a Standard material with a check pattern in the diffuse map
channel to any object in the scene.

4 Create a cube primitive and apply the new material to that object as
well. It is apparent that the mapping is not the same scale.

5 In the Material Editor, in the Checker procedural map Coordinates
rollout, ensure that real-world scale is active, and adjust the size 48 value
to 4 for both Width and Height.

NOTE

4 is 48 divided by 12, which compensates for the 1200% scaling.

6 Do this for every object in the scene and the mapping appears identical.

What happened to my 3ds Max Turned
Edges?

The 3ds Max FBX plug-in supports the turning of hidden edges. This support
is through triangulating the affected Poly objects into Editable Mesh objects.
Once the mesh is triangulated, all invisible edges are exposed and baked,
whether they are turned or not.

NOTE You can disable the plug-in's Preserve edge orientation option or use the
Mudbox preset to stop the automatic triangulation. See Preserve edge orientation
(page 39).

Editable polys have hidden edges. When you view a polygon in 3ds Max, the
hidden edge is invisible unless you turn on its Visibility. A hidden edge with
Visibility turned on appears as a dotted line when the Turn tool is activated.
This gives the impression that the Editable poly model is composed of polygons
when it is composed of triangles. The only difference is that the edges that
complete the triangles are normally hidden from view.

You can turn hidden edges in editable poly and mesh objects to modify the
shape of the hidden triangles within your polygons. This is a refining process
useful if you want to modify how polygons are subdivided. Turning the edges
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lets you avoid thin triangles in your polygons, for example. Turning hidden
edges is a refining process some 3ds Max modelers go through as a last step.

To turn an Edge in 3ds Max:

1 Create a Plane primitive in 3ds Max.

2 Convert the Plane01 object to Editable Poly.

3 Go to the Polygon sub-object level in the modifier stack and choose Edit
Polygons > Turn.

4 Press F4 to show hidden edges in the viewport.

5 If you click any hidden edges you can see that the edge now becomes a
solid line.

When you export this scene, hidden edge directions are retained by
converting editable poly objects to editable mesh objects.

Why does my geometry have facets?

If you see faceted geometry when you import files into 3ds Max using the 3ds
Max FBX plug-in, the Re-evaluate Smoothing groups (page 67) option might
have been activated. Disable this option to correctly import, for example,
Revit objects into 3ds Max.

Whenever you import a Revit file using FBX, deactivate the Re-evaluate
Smoothing groups option. This option is now deactivated by default in the
Autodesk Architectural Preset for all future releases of the 3ds Max FBX plug-in.

The Smoothing groups re-evaluation process potentially slows down the import
process, so your import process will speed up (depending upon file size) if you
deactivate it. This increase in speed occurs because the importer no longer
must evaluate every face in each of the geometries that already has a smoothing
group associated with it and then, assigning one or more when required.

Why do my MotionBuilder edges look
different?

Older versions of MotionBuilder (versions 2010 and earlier) do not support
Geometry Vertex Normals and can present issues with edge definition.
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If you are using an earlier version of MotionBuilder and this problem occurs,
you must activate the Split per-vertex Normals (page 35) option. When you
activate this option, geometry vertex normals are split based on edge
continuity. Vertex normals determine the visual smoothing between polygon
faces. They reflect how 3ds Max renders the polygons in smooth shaded mode.

This option only applies to older MotionBuilder workflows to ensure visual
fidelity of surface continuity. It lets you transfer hard edge information to
MotionBuilder.

Why would I use this?

Use this option to preserve whether edges are hard (divided) or not
(continuous) when you operate between 3ds Max or Maya and MotionBuilder
2010 and earlier. If you disable this option, all smoothing groups in 3ds Max
are ignored as well as all hard/soft edge information in Maya.

For example, a 3ds Max-created box that would normally have defined edges
would lose them, with all faces visually connected, without visible edges
dividing them, in MotionBuilder 2010 and earlier. This is result is hardly
noticeable for organic objects, but is very noticeable on hard surfaces such as
tables and cars, and so on.

See the Split per-vertex Normals (page 35) section for a workflow to import
FBX files exported from 3ds Max into MotionBuilder with proper edge
continuity while retaining the original 3ds Max edge continuity for import
back into 3ds Max.

Where are my display layer properties?

Display layer properties are only supported by layers that are not layer 0; the
3ds Max FBX plug-in does not recognize layer 0.

For example, if you have objects in Layer 0 and Layer 1, the 3ds Max FBX
plug-in ignores the Layer 0 properties but retains the layer property information
for Layer 1.

Where are my animation layers?

There are some specific situations where the 3ds Max FBX plug-in does not
export animation layers by default.
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Animation that exists on multiple layers does not export correctly as the 3ds
Max FBX Plug-in conditionally supports Biped animation layers.

As long as you are at the uppermost (top) layer, and use the Bake animation
(page 40) option in the FBX exporter, you can export all animation from the
top down on the layers that reside beneath the top layer.

If you do not activate Bake Animation, only the top layer of animation is
exported. This is because the 3ds Max FBX Plug-in Bake Animation option
scans through any unsupported controllers in 3ds Max and then re-samples
the animation for export.

TIP

You can also avoid this problem by collapsing all your layers into one before
export.

Where are my LOD attributes?

The 3ds Max FBX plug-in does not support Maya LOD attributes, due to
incompatibility with 3ds Max LOD attributes. See Maya LOD attributes (page
122) for more information about this limitation.

Where are my normals?

If you import an FBX file that contains Smoothing group data into 3ds Max
with the Smoothing groups option activated the FBX importer will import
only the smoothing group data and ignore any modifications made to the
normals. For example, this would happen if you modified the normal
directions, but the object also had smoothing group information.

This is due to a limitation, see Importing Explicit normals and Smoothing
Groups (page 122) for more.

Where did my constant keys go?

If you are missing keyframes at the end of your animation in an exported FBX
file, they may have been cleaned by the 3ds Max FBX plug-inConstant Key
Reducer (page 42) filter. When this filter is enabled, the plug-in removes any
consecutive keys that have the same value.

118 | Chapter 9   Troubleshooting and Limitations



For example, if you set five consecutive keys of the same value at frame 10,
12, 15, 20, and 24, the constant key reducer filter will remove all the redundant
keys except the one at frame 10.

During import, the plug-in may resample some animation curves. If this
resampling occurs, the 3ds Max FBX plug-in automatically applies the Constant
Key Reducer filter to reduce the amount of keys allocated in memory.

Why does the plug-in not match the help
documentation?

If you find something in your version of the 3ds Max FBX plug-in that does
not appear in the documentation, consult the readme file that accompanied
the plug-in. The readme will contain last-minute changes to the software that
are not reflected in the documentation.

It is also possible that your version of 3ds Max may not be the most recent
version. It is a good practice to check for updates, as each subsequent 3ds Max
FBX plug-in version has enhanced functionality, and is available free. See Web
updates (page 20) for instructions on how to verify that your plug-in version
is the latest.

NOTE

You can also use the comment link at the bottom of the online help to send
a comment to the FBX documentation team.

How can I revert to using the plug-in that
shipped with the software?

When you install the 3ds Max FBX plug-in, two instances of the plug-in are
installed: the actual FBX plug-in that is copied to the source directory
(C:\Program Files\Autodesk\3ds Max 2009\stdplugs) and a copy of the plug-in
that is stored in the FBX folder that you specified during the installation.

When you uninstall the 3ds Max FBX plug-in, the uninstall process removes
only the plug-in copy which is stored in the destination folder that you
specified during the installation.
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NOTE

If you do not want to lose access to the FBX plug-in that ships with 3ds Max,
select Yes to accept saving copies of the old plug-in whenever you install newer
versions of the FBX plug-ins.

Can I turn off Display Layer export/import

The 3ds Max FBX plug-in display layer support is not shown anywhere in the
FBX Plug-in interface because the plug-in does not need user input to execute
this process. This is because the plug-in assumes if there are display layers
included with the file, they are needed. There are no scripting options to
disable the FBX layer support.

If you still want to export without the display layers being considered by the
FBX plug-in, you must collapse the layers in the 3ds Max scene.

To collapse 3ds Max layers:

This example is for a scene with multiple objects and layers, such as 3 objects
with 3 layers (one object in each).

1 Select all objects in the scene.

2 Select the Display Layer 0 in the Layer Manager, and click the plus sign
that adds all selected objects to the selected layer.

3 Then delete each display layer, one by one, to eliminate the layers from
being exported. (3ds Max does not allow multiple layers to be deleted
at once.)

Limitations
The following section contains a list of known limitations for this version of
the 3ds Max FBX plug-in. If you have problems with the plug-in that are not
listed here, refer to the Troubleshooting (page 103) section.
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Animation controllers

During export, if the plug-in detects that an animation controller has an
undefined time range, it automatically adjusts it to use the scene animation
interval. This way, the number of animation keys generated are limited.

Preset Bake Animation settings

You cannot save Bake animation (page 40) settings (Start/End/Step values) in
Preset files. If you created a preset that had specific settings for the Bake
Animations values, these values will not be used the next time you load the
preset. Instead, the FBX plug-in will always default to the values set for the
scene's timeline.

For example, if the animation in the scene is 102 frames long, the Start value
will be 1, the End value will be 102, and the Step value will be 1, regardless
of what values you may have stored in the preset for this setting.

Non-orthogonal matrices

“Orthogonal” is a term used to describe two vectors that are perpendicular (at
90 degrees) to each other. In 3D space, when the X, Y, or Z-Axes are not
perpendicular, they are considered “non-orthogonal” and the FBX plug-in
does not support their representation as a matrix. For example, a
non-orthogonal set of axes can occur when you use rotation and scaling to
skew an object.

Because the FBX plug-in assumes that there is always a 90 degree angle between
the X, Y, and Z axes, it can support only orthogonal matrices. Any transformed
axes that have non-orthogonal TRS matrices are ignored by the FBX plug-in,
so it does not import or export effects created when axes are not orthographic.
Because of this, any non-orthogonal effect (such as skewing) is lost.

This can cause problems even when you have transformation data that has
been inherited from other objects, for example, scaling via a parent object
where the result is a non-orthogonal local TRS matrix.
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Maya LOD attributes

LOD (Level of Detail) attributes in Maya files are ignored when you import
them into 3ds Max.

In 3ds Max, the group will be created and the LOD Utility will be applied to
the group. Default values will be used for threshold attributes. Since Maya
uses a camera distance and 3ds Max a pixel resolution, these LOD attributes
are incompatible and the 3ds Max importer and exporter ignores them.

Importing Explicit Normals and Smoothing
Groups

A limitation occurs when you import an FBX file that contains Smoothing
group data into 3ds Max with the Smoothing groups option activated.

If any objects in the file contain explicit normal modifications, the FBX
importer will import only the smoothing group data and ignore modifications
made to the normals. For example, if you modified the normal directions, but
the object also has smoothing group information.

The 3ds Max FBX plug-in does not export smoothing group data by default.

Environmental texture maps

The 3ds Max FBX Plug-in does not support environmental texture maps
(Environ option).

Standard material map channel values

The 3ds Max FBX plug-in does not retain amount values for most Standard
material map channels, such as Diffuse and Specular level when exporting.
The FBX format saves only the bump map channel amount and sets all other
channels to a value of 100 on import.

The 3ds Max FBX plug-in reads the glossiness and specularity amounts from
Shader Basic Parameters and not from the Maps rollout in the Material Editor.
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Morph information

The 3ds Max FBX plug-in does not export Morph information with Patch
geometry.

Locked Ambient and Diffuse channels

The 3ds Max FBX plug-in does not export 3ds Max Lock information from
Ambient and Diffuse channels. If you define a texture in the Ambient channel
when you import an FBX file into 3ds Max, the Ambient, and Diffuse channels
become unlocked. To preserve the locked state of the channel, you must lock
them after you import the scene.

Photometric lights

The FBX Exporter converts Photometric lights to Standard lights. Photometric
lights from Revit 2009 and later are supported by 3ds Max 2009 and later.

Export issue

A limitation exists where objects exported with the FBX format remain in the
last state shown in the Viewport. The plug-in exports any vertex animation
on an object in its current PRS coordinates. For example, if you export a
cylinder with a 100-frame animated Bend modifier at frame 50, the scene
shows the cylinder at a 50-percent bend.

Workaround

To accommodate this limitation, position your time slider at the point in the
animation you want to export. To retain the entire animation, create a selection
set for animated objects. Then, activate the Include > Animation > Point Cache
File(s) option in the 3ds Max FBX Exporter window.

Biped layers

Multiple layer animation may not export.
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The 3ds Max FBX plug-in conditionally supports Biped animation layers. If
you highlight a layer and export it with the Media & Entertainment default
preset, you will only export the animation from that specific layer. See Where
are my keys/animation layers? (page 117) for more.

TCB interpolation controllers

For improved interoperability, keyframe animation set on controllers with
TCB interpolation or tangent slopes set to Fast, Slow, or User resamples
systematically.

Scale compensation

If you modify the scale of joints that are parents of other joints in Maya, they
do not import correctly into 3ds Max. This import problem occurs because
3ds Max does not support scale compensate settings in Maya.

What does Scale Compensate do?

If you scale a parent joint in Maya using scale compensation, it creates an
offset for the child joint rather than scaling it.

But if you do the same thing in 3ds Max, the child scales and creates no offsets.

Since 3ds Max does not support Scale Compensate, any joint hierarchy you
use in Maya with scale compensate looks wrong in 3ds Max.

When do I de-activate scale compensate so it imports correctly into
3ds Max?

Deactivate the scale compensate for joints only if you have modified the scale
of any joints that are parents of other joints.

If all your joints are the same scale, you do not have to deactivate this setting
in Maya.

To deactivate scale compensate in Maya:

1 In Maya, select the child joint.

2 In the Attribute Editor, deactivate the Segment Scale Compensate
attribute.
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This option deactivates the scale compensation setting.

Bitmaps, procedural, and map channels

The 3ds Max FBX plug-in processes any type of image map in almost any
standard material channel. Anything that you map in the Diffuse, Specular
and other channels translate to FBX, as long as they are not procedural maps.

The FBX plug-in can transfer bitmap image and Composite Layer maps.
However, the FBX plug-in ignores files created with procedural mapping
systems like Dent or Smoke as it does not currently support these mapping
types.

SupportMap channel

SupportedAmbient

SupportedDiffuse

SupportedSpecular color

SupportedSpecular level

SupportedGlossiness

SupportedSelf-Illumination

SupportedOpacity

SupportedBump

SupportedReflection

SupportedDisplacement

NOTE

The FBX Plug-in ignores any maps applied to unsupported channels on export.
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Selection sets

A known limitation exists where sets that contain NURBS subcomponents,
such as Isoparm, Control Vertex, or Surface Patch, do not retain the NURBS
subcomponent information. This results in an empty set on import.

Missing texture maps in DAE files

A 3ds Max limitation causes texture maps to disappear from objects when
they are imported into Maya in Collada (DAE) format.
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3ds Max FBX plug-in
glossary

.fbm folder

The folder generated when you export an FBX file with the Embed Media
option activated. The FBM folder contains all the associated textures in the
FBX file. The “M” in FBM is for “Media”. See Embed media (page 49).

.mc file

Autodesk point cache file extension.

.pc2 file

Legacy 3ds Max point cache file extension.

.xml file

Extensible Markup language file. The 3ds Max FBX plug-in creates an XML
file when it processes Autodesk point cache data.

ASCII

Stands for American Standard Code for Information Interchange. This is a
format that represents characters numerically to which you can can export
your FBX file.

bake

Baking is a re-sampling of the animation data within your scenes.

Bind pose

(Maya) In animation, the default position of a skeleton, used to keep track of
transformation attributes for all the skeleton’s joints and influence objects.

bone

Bones are 3D objects that you can link like human joints to create animation.
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curve

See FCurve (page 128).

Degrees of Freedom (DOF)

Degrees of Freedom (DOF) are MotionBuilder properties that let you limit
translation, rotation, and scaling of objects or animated hierarchies. Defining
Degrees of Freedom for objects in a scene lets you restrict their range of
movement.

destination application

The application in which you want to use your FBX file.

dummy

A type of 3ds Max helper object, a placeholder.

edge

An edge is a straight or curved line that connects two vertices in a mesh object
or spline. You can modify object shapes by transforming its edges.

Euler

In animation, a method of rotation that uses three angle values (X, Y and Z)
plus a rotation order to specify three-dimensional orientation. Euler rotation
has several drawbacks, including Gimbal lock (page 129) and choppy
interpolation between keyframes.

FBX file

An Autodesk FBX format file used as a universal 3D Asset Exchange.

FCurve

(MotionBuilder) (Also referred to as a Function Curve.) A graphic depiction
of an animated value. The time and value of the animated value displays on
two axes: the vertical axis representing the value, and the horizontal axis
representing the time.

fps

Frames per second.

geometry

(Maya) In general, a surface, NURBS (page 130), NURBS curve, subdivision
surface, or polygonal surface (mesh). (3ds Max) Geometry refers to all objects
that are not cameras or lights. Meshes, polys, patches, NURBS, splines, helper
objects, etc.
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Geometry cache

A file that stores positions of vertices. Cache files let you preview the results
of a simulation without rendering the scene.

Gimbal lock

A Gimbal Lock occurs when you rotate one axis and accidentally align the
two other axes. When these two axes align, you lose one axis because you
cannot separate them. When a gimbal lock occurs, your bone can rotate only
in two axes instead of all three.

host application

The application used to create the file you are going to save as an FBX file.

key

A reference point, or key point, that marks the position of an important action
or change in a scene at a specific point in time.

mesh

In polygonal modeling, a collection of polygons, which can be of different
types (triangles, quads, n-sided).

morph

Morph is a method of 3D computer animation that is sometimes used as an
alternative to skeletal animation. Morph target animation is stored as a series
of vertex positions. In each keyframe of the animation, the vertices are moved
to a different position.

Depending on the renderer, vertices move along paths to fill the empty time
between keyframes. The renderer can also switch between different positions.

Animation composed in one 3D application suite may require transfer to
another, such as for rendering. To avoid export issues, native animation formats
often convert to morph target animation. This is necessary to accomodate the
implementation of bones and other special effects in different 3D application
suites.

normal

In modeling, the directional line perpendicular to a surface. Polygon normals
indicate the orientation of polygonal faces. Because shaded (or rendered) faces
are visible only when the normals are facing towards the viewer, it is sometimes
necessary to reverse a normal to correct a face’s orientation.
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NURBS

Non-Uniform Rational B-Spline. A type of geometry that includes curves,
patches, surfaces, etc. NURBS are a superset of conics, splines, and Bezier
curves. They are particularly suited for modeling in 3D, because they provide
excellent continuity with a minimum number of control points.

NURMS

Non-Uniform Rational MeshSmooth. A NURMS object is similar to a NURBS
object in that you can set different weights for each control vertex.

Orthogonal

Describes vectors that are perpendicular (at 90 degrees) to each other. In 3D
space, when the X, Y, or Z-axes are not perpendicular, they are considered
"non-orthogonal". The 3ds Max FBX plug-in has a limitation related to
non-orthogonal axes. See Non-orthogonal matrices (page 121).

Point cache

(3ds Max) A file (or series of files) that stores positions of vertices. Cache files
let you preview the results of a simulation without rendering the scene.

polygons

An n-sided shape defined by a group of ordered vertices and the edges that
are defined between pairs of those vertices. Polygons can be either simple
shapes, such as polygonal primitives, or complex models built from the various
polygonal tools. A polygonal object can be closed, open, or made up of shells,
which are disjointed pieces of geometry. Also known as mesh.

procedural image map

An image not composed of a fixed matrix of colors, but rather generated
procedurally by a mathematical algorithm. You cannot transfer these textures
through the FBX format.

Quaternion interpolation

A method of rotation that uses a unit quaternion (a quaternion of length one)
to represent an orientation in three dimensions. A quaternion is a four
dimensional extension to complex numbers. Quaternion rotation is an option
that is useful for avoiding Gimbal lock (page 129).

resample

The process of creating a key for every nth frame of an animation's
interpolation (or curve).
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selection set

(3ds Max) A group of objects that have a name assigned to them.

skin

A deformation tool that lets one object deform another, for example a skeleton
deforms a mesh.

smoothing groups

Smoothing groups define whether a surface is rendered with hard edges or
soft surfaces.

Smoothing groups are numbers assigned to the faces or patches of an object.
Each face or patch can carry a maximum of 32 smoothing groups. If two faces
or patches share an edge and share the same smoothing group, they render
as a smooth surface. If they do not share the same smoothing group, the edge
between them renders as a corner.

take

(MotionBuilder) An animation scene done between one start and the following
stop, a segment.

triangles

Objects in 3D scenes are composed of triangles. The triangles are defined as
three XYZ vertex coordinates.

UI

User interface.

up-axis

The up axis is the global axis that is pointing upwards.(Maya) There are two
choices of axis (Y or Z) as the world up direction. The Y axis is used as the
default up axis.(3ds Max) The Z axis is used as the world up axis. This cannot
be changed.

Y-axis

Maya’s default up-axis.

Z-axis

3ds Max’s default up-axis.
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DAE
export 57
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workaround 105
texture limitation 126

deformations (export) 42
display layers 117
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preserving turned edges 115
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FBX plug-in UI 19
FBXExporterSetParam
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Cameras 94
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(export) 38
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work around 35
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